Create a Windows account that has a Microsoft Exchange 2010 mailbox................................................................. 23
Configure Microsoft Exchange 2010 permissions for the Windows account................................................................. 23
Turn off client throttling in Microsoft Exchange 2010.................................................................................................. 24
Increase the maximum number of connections to the Address Book service in Microsoft Exchange 2010......... 24
Configure a management role for Microsoft Exchange Web Services...................................................................... 25
Configure the BlackBerry Enterprise Server to run without public folders................................................................. 25
Permit meeting requests from outside of your organization when using Microsoft Exchange Web Services for Microsoft Exchange 2010........................................................................................................... 25
Configuring a Microsoft Exchange 2007 messaging environment.................................................................................. 26
  Create a Windows account that has a Microsoft Exchange 2007 mailbox................................................................. 26
  Configure Microsoft Exchange 2007 permissions for the Windows account.......................................................... 26
  Permit BlackBerry device users to send email messages in a Microsoft Exchange environment............................. 27
  Permit meeting requests from outside of your organization when using Microsoft Exchange Web Services for Microsoft Exchange 2007........................................................................................................... 27
Configuring a Microsoft Exchange 2003 messaging environment.................................................................................. 28
  Create a Windows account that has a Microsoft Exchange 2003 mailbox................................................................. 28
  Configure Microsoft Exchange 2003 permissions for the Windows account.......................................................... 28
  Permit BlackBerry device users to send email messages in a Microsoft Exchange environment............................. 29
Configure permissions for the Windows account.......................................................................................................... 30
Permit BlackBerry device users to send email messages in a Microsoft Exchange environment............................. 30
Prevent the Microsoft Exchange known issues for wireless calendar synchronization................................................. 31
Verify if the Windows account can access a user account in Microsoft Exchange......................................................... 32
Configuring connections for the BlackBerry Enterprise Server databases........................................................................ 32
  Specifying permissions when you connect to the BlackBerry Enterprise Server databases using Windows authentication or Microsoft SQL Server authentication................................................................. 33
  Configuring authentication to the BlackBerry MDS Integration Service database..................................................... 34
  Create a BlackBerry Configuration Database..................................................................................................................... 34
Install the SNMP service for monitoring by the BlackBerry Monitoring Service.............................................................. 36
Creating a BlackBerry Administration Service pool using DNS round robin that includes the BlackBerry Web Desktop Manager......................................................................................................................................................... 36
Creating a BlackBerry MDS Integration Service pool..................................................................................................... 37
Create the DNS record for a BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance ................................................................................................................................................................. 37
Persistent socket connections for the BlackBerry Collaboration Service.................................................................... 38
Applications that are installed with the BlackBerry Enterprise Server components.............................................................. 38
6 Installing the BlackBerry Enterprise Server software
- Prerequisites: Installing the BlackBerry Enterprise Server software
- Install the BlackBerry Enterprise Server software
  - Specifying a name for the BlackBerry Administration Service pool during the installation process
- Install a BlackBerry Enterprise Server component on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server
- Install a standalone BlackBerry Router
- Install the BlackBerry Monitoring Service software
- Installing a standby BlackBerry Enterprise Server
- Install a standby BlackBerry Enterprise Server

7 Postinstallation tasks
- Test the BlackBerry Enterprise Server installation
- Install the BlackBerry database notification system
- Best practice: Running the BlackBerry Enterprise Server
- Configuring support for Unicode languages
  - Configure support for Unicode languages
  - Change the character encoding that the BlackBerry Enterprise Server uses to send Unicode messages
  - Configure support for Unicode text in calendars on BlackBerry devices in a Microsoft Exchange environment
- Configure the BlackBerry Administration Service instances in a pool to communicate across network subnets
- Log in to the BlackBerry Administration Service for the first time
  - There is a problem with this website's security certificate
- Configuring a computer for monitoring
  - Configure the SNMP service for monitoring
  - Configure the BlackBerry Monitoring Service to monitor a BlackBerry Enterprise Server
- Configuring communication with distributed components
  - Connecting to a BlackBerry Attachment Service
  - Connecting to a BlackBerry Router
  - Configure multiple BlackBerry Enterprise Server instances to use the same BlackBerry MDS Integration Service
- Restrict database permissions for the BlackBerry Attachment Service
- Configuring minimum Microsoft SQL Server permissions for the Windows account
  - Configure minimum Microsoft SQL Server permissions for the Windows account
- Changing the BlackBerry Configuration Database
Overview: BlackBerry Enterprise Server

The BlackBerry® Enterprise Server is designed to be a secure, centralized link between an organization's wireless network, communications software, applications, and BlackBerry devices. The BlackBerry Enterprise Server integrates with your organization's existing infrastructure, which can include messaging and collaboration software, calendar and contact information, wireless Internet and intranet access, and custom applications, to provide BlackBerry device users with mobile access to your organization's resources.

The BlackBerry Enterprise Server supports AES and Triple DES encryption to protect and ensure the integrity of wireless data that is transmitted between the BlackBerry Enterprise Server components and BlackBerry devices. You can select from more than 450 IT policy rules that you can configure to control the features of the BlackBerry devices that are used in your organization's environment.

The BlackBerry Enterprise Server supports several optional components and configurations to meet your organization's requirements. The BlackBerry Collaboration Service integrates with supported third-party instant messaging servers to permit users to access your organization's instant messaging system from their BlackBerry devices using the BlackBerry instant messaging client. The BlackBerry MDS Integration Service supports custom application development and distribution. You can configure the BlackBerry Enterprise Server and the BlackBerry Enterprise Server components to support high availability to enhance the consistency and reliability of your organization's environment.

You can manage the BlackBerry Enterprise Server, BlackBerry devices, and user accounts using the BlackBerry Administration Service, a web application that is accessible from any computer that can access the computer that hosts the BlackBerry Administration Service. You can use the BlackBerry Administration Service to manage a BlackBerry Domain, which consists of one or more BlackBerry Enterprise Server instances and remote components that use a single BlackBerry Configuration Database.
Planning a BlackBerry Enterprise Server installation

You can install all BlackBerry® Enterprise Server components on one computer, or you can install specific components on separate computers. You should consider any impact to system resources before you decide where to install the components.

You install all components on one computer if you do not plan to activate many BlackBerry devices, if you determine that the computer can manage the volume of traffic for the BlackBerry Enterprise Server components, and if it is acceptable that the computer has direct access to the Internet, without being located in the DMZ.

If you want to configure high availability, you must install an additional BlackBerry Enterprise Server on a computer that is separate from the computer that hosts the primary BlackBerry Enterprise Server. During the installation process, you specify that the duplicate BlackBerry Enterprise Server is the standby BlackBerry Enterprise Server.

For performance information, see the BlackBerry Enterprise Server Performance Benchmarking Guide.

For more information about high availability, see the BlackBerry Enterprise Server Planning Guide.

Installing all BlackBerry Enterprise Server components on one computer

If you want to evaluate the BlackBerry® Enterprise Server or complete a BlackBerry Enterprise Server installation for a small number of users, you can install all the BlackBerry Enterprise Server components on the same computer.

During the installation process you can choose to install the BlackBerry Collaboration Service, BlackBerry MDS Integration Service, BlackBerry Monitoring Service, and BlackBerry® Web Desktop Manager with the BlackBerry Enterprise Server. All of the other BlackBerry Enterprise Server components are installed automatically when you install the BlackBerry Enterprise Server. The BlackBerry MDS Integration Service is an optional component that you require only if you want users to use BlackBerry® MDS Runtime Applications on BlackBerry devices.

Related topics
System requirements, 12
Preinstallation tasks, 23
Installing the BlackBerry Enterprise Server software, 40
Hardware requirements: BlackBerry Enterprise Server, 11

Installing the BlackBerry Administration Service

The BlackBerry® Administration Service permits you to manage a BlackBerry Domain through a web-based application. A BlackBerry Domain consists of one BlackBerry Configuration Database and all BlackBerry® Enterprise Server instances and remote components that use the BlackBerry Configuration Database.
You can install the BlackBerry Administration Service with other BlackBerry Enterprise Server components or by itself on a separate computer. You can install the BlackBerry Administration Service on a separate computer to limit the impact that the BlackBerry Administration Service might have on system resources and to prevent administrators in your organization from accessing any part of the computer that hosts the BlackBerry Enterprise Server. If you install the BlackBerry Administration Service before you install a BlackBerry Enterprise Server, the installation process can create and populate the BlackBerry Configuration Database.

When you install the BlackBerry Administration Service, you can install the BlackBerry® Web Desktop Manager and select whether you want administrators to use Windows® authentication or BlackBerry Administration Service authentication to log in to the BlackBerry Administration Service. You must verify that all administrators have access to the BlackBerry Administration Service web address (https://<computer_name>:<port>/webconsole/app).

Related topics
Installing the BlackBerry Enterprise Server software, 40
Hardware requirements: BlackBerry Enterprise Server, 11
System requirements: BlackBerry Administration Service and BlackBerry Web Desktop Manager, 13
System requirements for your organization's environment, 18
System requirements: Browsers for BlackBerry Web Desktop Manager, BlackBerry Administration Service, and BlackBerry Monitoring Service users, 19

Installing the BlackBerry Attachment Service

The BlackBerry® Attachment Service converts supported attachments into a format that users can view on their BlackBerry devices. By default, the BlackBerry® Enterprise Server includes the BlackBerry Attachment Service.

The BlackBerry Attachment Service might use increased system resources when it processes numerous conversion requests simultaneously. If you want to increase the number of conversion requests that can occur concurrently without impacting message delivery, you can install a BlackBerry Attachment Service on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server.

You can connect multiple BlackBerry Enterprise Server instances and BlackBerry MDS Connection Service instances to a BlackBerry Attachment Service instance.

When you install the BlackBerry Attachment Service on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server, the installation process installs the BlackBerry Attachment Service and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Attachment Service and restarts it if it stops responding.

Related topics
Installing the BlackBerry Enterprise Server software, 40
Hardware requirements: BlackBerry Enterprise Server, 11
System requirements: BlackBerry Attachment Service, 15

Installing the BlackBerry Collaboration Service

The BlackBerry® Collaboration Service provides an encrypted connection between your organization's instant messaging server and the collaboration client on the BlackBerry device so that users can start and manage instant messaging conversations on their BlackBerry devices.
If you want to maximize the number of sockets available so that the BlackBerry Collaboration Service can respond to more requests from the collaboration clients, you can install the BlackBerry Collaboration Service by itself on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server.

If you install the BlackBerry Collaboration Service on a separate computer, the installation process installs the BlackBerry Collaboration Service and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Collaboration Service and restarts it if it stops responding.

You can connect multiple BlackBerry Enterprise Server instances to a BlackBerry Collaboration Service instance.

A different type of BlackBerry Collaboration Service exists for each instant messaging environment. For example, a BlackBerry Collaboration Service exists for Microsoft® Office Communications Server 2007, and a different BlackBerry Collaboration Service exists for IBM® Lotus® Sametime®. You can install only one type of BlackBerry Collaboration Service in your organization's environment. Users can use only one type of collaboration client on their BlackBerry devices.

Related topics
Installing the BlackBerry Enterprise Server software, 40
Hardware requirements: BlackBerry Enterprise Server, 11
System requirements: BlackBerry Collaboration Service, 16

Installing the BlackBerry MDS Connection Service

The BlackBerry® MDS Connection Service provides users with access to online content and applications on your organization's intranet or the Internet. By default, the BlackBerry® Enterprise Server includes the BlackBerry MDS Connection Service.

The BlackBerry MDS Connection Service might use increased system resources when it processes content requests. If you want to minimize the impact this has on message delivery, you can install the BlackBerry MDS Connection Service by itself on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server.

You can connect multiple BlackBerry Enterprise Server instances to a BlackBerry MDS Connection Service instance.

When you install the BlackBerry MDS Connection Service on a separate computer, you must assign at least one BlackBerry Enterprise Server instance to it during the installation process. The BlackBerry MDS Connection Service uses the BlackBerry Enterprise Server information to connect to the BlackBerry Attachment Service.

When you install the BlackBerry MDS Connection Service on a separate computer, the installation process installs the BlackBerry MDS Connection Service and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry MDS Connection Service and restarts it if it stops responding.

Related topics
Installing the BlackBerry Enterprise Server software, 40
Hardware requirements: BlackBerry Enterprise Server, 11
System requirements: BlackBerry MDS Connection Service, 16
System requirements for your organization's environment, 18
Installing the BlackBerry MDS Integration Service

The BlackBerry® MDS Integration Service connects the BlackBerry MDS Runtime Application on BlackBerry devices to enterprise applications.

The BlackBerry MDS Integration Service might use increased system resources when it processes content requests. If you want to minimize the impact this has on message delivery, you can install the BlackBerry MDS Integration Service by itself on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server.

When you install the BlackBerry MDS Integration Service, you must select whether to create a BlackBerry MDS Integration Service pool, or add the BlackBerry MDS Integration Service instance to an existing pool. The BlackBerry MDS Integration Service pool permits multiple BlackBerry MDS Integration Service instances to balance the volume of traffic between them. For more information on BlackBerry MDS Integration Service pools, see the BlackBerry Enterprise Server Planning Guide.

When you install the BlackBerry MDS Integration Service on a separate computer, the installation process installs the BlackBerry MDS Integration Service and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry MDS Integration Service and restarts it if it stops responding.

The BlackBerry MDS Integration Service stores application data in the BlackBerry MDS Integration Service database. The setup application installs the BlackBerry MDS Integration Service database on the same database server that hosts the BlackBerry Configuration Database. You can install multiple BlackBerry MDS Integration Service instances that can use the same BlackBerry MDS Integration Service database.

During the installation process, you create the administrator account and publisher account for the BlackBerry MDS Integration Service. The BlackBerry MDS Integration Service uses the administrator account and publisher account when it publishes applications.

Related topics
Installing the BlackBerry Enterprise Server software, 40
Hardware requirements: BlackBerry Enterprise Server, 11
System requirements: BlackBerry MDS Integration Service, 17

Installing the BlackBerry Monitoring Service

The BlackBerry® Monitoring Service monitors BlackBerry® Enterprise Server component activity, and, if configured, sends notification messages to administrators.

You can install only one BlackBerry Monitoring Service in each BlackBerry Domain in your organization's environment. The BlackBerry Monitoring Service stores its data in its own database. The BlackBerry Monitoring Service can monitor all BlackBerry Enterprise Server instances in your organization's environment including remote BlackBerry Enterprise Server instances and components.
You can install the BlackBerry Monitoring Service database on the computer that hosts the BlackBerry Monitoring Service, on the database server that hosts the BlackBerry Configuration Database, or on another database server. You can install the BlackBerry Monitoring Service database on a database server that does not host the BlackBerry Configuration Database if you want the BlackBerry Monitoring Service database to be available when the BlackBerry Configuration Database is unavailable, if your organization's system resources are limited, or if you want to run reports frequently.

Related topics
Installing the BlackBerry Enterprise Server software, 40
Hardware requirements: BlackBerry Enterprise Server, 11
System requirements: BlackBerry Monitoring Service, 17
System requirements: Browsers for BlackBerry Web Desktop Manager, BlackBerry Administration Service, and BlackBerry Monitoring Service users, 19

Installing the BlackBerry Router

The BlackBerry® Router connects to the wireless network and sends data to and from BlackBerry devices.

You can install a BlackBerry Router with other BlackBerry® Enterprise Server components or by itself on a separate computer. You can install the BlackBerry Router on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server if you want to install the BlackBerry Router in the DMZ, or to install standby BlackBerry Router instances as failover components in case the primary BlackBerry Router is unavailable.

You can connect multiple BlackBerry Enterprise Server instances to a BlackBerry Router instance.

If you install the BlackBerry Router on a separate computer, the installation process installs the BlackBerry Router and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Router and restarts it if it stops responding.

Related topics
Installing the BlackBerry Enterprise Server software, 40
Hardware requirements: BlackBerry Enterprise Server, 11
System requirements: BlackBerry Router, 18
Hardware requirements: BlackBerry Enterprise Server

The following are requirements for a BlackBerry® Enterprise Server and the BlackBerry Enterprise Server components that you install on a single computer, and excludes the BlackBerry Collaboration Service and the BlackBerry MDS Integration Service. The requirements are for a BlackBerry Enterprise Server environment that includes users that receive 100 to 200 email messages each day.

You can improve the performance and reliability of the BlackBerry Enterprise Server by installing the BlackBerry Enterprise Server components on multiple computers. If your BlackBerry Enterprise Server environment supports up to 1000 users, install the BlackBerry Configuration Database on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server. If your BlackBerry Enterprise Server environment supports up to 2000 users, install the BlackBerry Configuration Database and the BlackBerry Administration Service on computers that are separate from the computer that hosts the BlackBerry Enterprise Server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| BlackBerry Enterprise Server that supports up to 200 users | • Single processor, 2.0 GHz Intel® Xeon® (two processors recommended)  
• 2 GB of memory  
• 2 drives, RAID 1 |
| BlackBerry Enterprise Server that supports up to 500 users | • Two processors, 2.0 GHz Intel Xeon  
• 2 GB of memory  
• 2 drives, RAID 1 |
| BlackBerry Enterprise Server that supports up to 1000 users | • Two processors, 2.0 GHz Intel Xeon  
• 3 GB of memory  
• 2 drives, RAID 1 |
| BlackBerry Enterprise Server that supports up to 2000 users | • Two processors, 2.8 GHz Intel Xeon or two processors, 1.86 GHz Intel Xeon 5100 Series (Dual Core)  
• 4 GB of memory  
• 2 drives, RAID 1 or 4 drives, RAID 1+0 |
## System requirements

For information about calculating hardware requirements, visit www.blackberry.com/go/serverdocs to see the BlackBerry Enterprise Server Capacity Calculator and BlackBerry Enterprise Server Performance Benchmarking Guide.

### System requirements: BlackBerry Enterprise Server

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>operating system</strong></td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server® 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td><strong>Microsoft® Exchange system tools</strong></td>
<td>Any of the following system tools:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft® Exchange 2003 SP2 System Manager</td>
</tr>
<tr>
<td></td>
<td>• Microsoft® Exchange Server MAPI client and CDO 1.2.1</td>
</tr>
<tr>
<td></td>
<td>To support Microsoft Exchange Server 2010, you must install version 6.5.8147.0 or later of Microsoft Exchange Server MAPI client and CDO 1.2.1.</td>
</tr>
<tr>
<td></td>
<td>For more information about installing MAPI and CDO patches on your organization's BlackBerry® Enterprise Server, visit <a href="http://support.microsoft.com">http://support.microsoft.com</a> to read article 917481 and visit <a href="http://www.blackberry.com/btsc">http://www.blackberry.com/btsc</a> to read article KB15779.</td>
</tr>
<tr>
<td><strong>Microsoft Exchange organization of the system tools for the messaging server</strong></td>
<td>The same Microsoft Exchange organization that the messaging server uses</td>
</tr>
<tr>
<td><strong>CDO library</strong></td>
<td>To support the latest version of Microsoft Exchange Server in your organization's environment, the latest version of the CDO library that applies to the Microsoft Exchange Server version</td>
</tr>
<tr>
<td><strong>Unicode support for calendars</strong></td>
<td>To support Microsoft Exchange Server 2003, the following Microsoft hotfixes:</td>
</tr>
<tr>
<td></td>
<td>• 913643 on the messaging server</td>
</tr>
<tr>
<td></td>
<td>• 923537 on the computer that hosts the BlackBerry Enterprise Server</td>
</tr>
<tr>
<td><strong>database conditions for the BlackBerry MDS Integration Service</strong></td>
<td>A database server that hosts the BlackBerry Configuration Database</td>
</tr>
<tr>
<td>Item</td>
<td>Requirement</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>static IP address for the computer</td>
<td>To install the BlackBerry MDS Integration Service or the BlackBerry Administration Service in a pool, a static IP address for the computer that hosts the component</td>
</tr>
<tr>
<td>browser</td>
<td>Windows® Internet Explorer® 7.0 to 8.0 with language preferences configured to display encoded web pages</td>
</tr>
<tr>
<td>media player</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• if using Windows Server 2008, to support audio attachments, Windows Media® Format SDK (for more information, visit <a href="http://support.microsoft.com">http://support.microsoft.com</a> to read article 972098)</td>
</tr>
<tr>
<td></td>
<td>• if using Windows Server 2003, to support audio attachments, Windows Media Player 9 or later</td>
</tr>
<tr>
<td>network proximity</td>
<td>A high-speed, switched connection between the BlackBerry Enterprise Server and messaging servers</td>
</tr>
<tr>
<td>monitoring</td>
<td>To support the BlackBerry Monitoring Service, the SNMP service must be running</td>
</tr>
</tbody>
</table>

**System requirements: BlackBerry Administration Service and BlackBerry Web Desktop Manager**

The following system requirements apply when you install the BlackBerry® Administration Service and BlackBerry® Web Desktop Manager on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server® 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>• Microsoft® hotfix 955839 installed on the computer that hosts the BlackBerry Administration Service and BlackBerry Web Desktop Manager</td>
</tr>
<tr>
<td>memory</td>
<td>A minimum of 1.2 GB of memory</td>
</tr>
</tbody>
</table>
### System requirements: BlackBerry Enterprise Server databases

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>hardware load balancer</td>
<td>If you configured high availability for the BlackBerry Administration Service using a hardware load balancer, you must implement session persistence for SSL connections. For information on how to implement session persistence, contact the vendor of your hardware load balancer.</td>
</tr>
<tr>
<td>database management system</td>
<td>Any of the following database management systems:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft® SQL Server® 2005 SP3 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 Express Edition SP3</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 SP1 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 Express Edition SP1 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2008 R2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td>collation setting</td>
<td>To configure collation settings, the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• database server collation configured to default case-insensitive</td>
</tr>
<tr>
<td></td>
<td>• BlackBerry® Configuration Database collation configured to default case-insensitive</td>
</tr>
<tr>
<td></td>
<td>• collation must be the same for the Microsoft SQL Server instance and the database server that hosts the BlackBerry database notification system (BlackBerry Configuration Database)</td>
</tr>
<tr>
<td></td>
<td>• default collations are suggested though non-default collations are supported (for more information, visit <a href="http://www.blackberry.com/btsc/">http://www.blackberry.com/btsc/</a> to read articles KB04785 and KB15534)</td>
</tr>
<tr>
<td>database connectivity</td>
<td>TCP/IP network protocols turned on</td>
</tr>
<tr>
<td>database mirroring</td>
<td>To support database mirroring for the BlackBerry Configuration Database or BlackBerry MDS Integration Service database, the following conditions:</td>
</tr>
<tr>
<td></td>
<td>• the database server must be Microsoft SQL Server 2005 SP3 Enterprise Edition or Standard Edition (32-bit or 64-bit), Microsoft SQL Server 2008 SP1 Enterprise Edition or Standard Edition (32-bit or 64-bit), or Microsoft SQL Server 2008 R2 Enterprise Edition or Standard Edition (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• the mirror database must reside on a different computer from the principal database</td>
</tr>
</tbody>
</table>
Item | Requirement
--- | ---
|  | • the Microsoft SQL Server instances for both the principal and mirrored databases must be the same version and edition
|  | • only use static port number 1433
|  | • do not use named instances
|  | • verify that the SQL Server Browser service is running
|  | • turn off the Named Pipes option in the Microsoft SQL Server Native Client on the computers that host the BlackBerry® Enterprise Server instances

database transactional replication | To support database transactional replication for the BlackBerry Configuration Database or BlackBerry MDS Integration Service database, the following conditions:
|  | • the database server must be Microsoft SQL Server 2005 SP3 or later
|  | • the database server that hosts the replicated database must use the same version and build as the database server that hosts the primary database

**System requirements: BlackBerry Attachment Service**

The following system requirements apply when you install the BlackBerry® Attachment Service on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| operating system | Any of the following operating systems:  
• Windows Server® 2003 SP2 (32-bit or 64-bit)  
• Windows Server 2003 R2 SP2 (32-bit or 64-bit)  
• Windows Server 2008 SP2 (32-bit or 64-bit)  
• Windows Server 2008 R2 |
| media player | One of the following:  
• if using Windows Server 2008, to support audio attachments, Windows Media® Format SDK (for more information, visit [http://support.microsoft.com](http://support.microsoft.com) to read article KB972098)  
• if using Windows Server 2003, to support audio attachments, Windows Media Player 9 or later |
| browser | Windows® Internet Explorer® 7.0 to 8.0 with language preferences configured to display encoded web pages |
**System requirements: BlackBerry Collaboration Service**

The following system requirements apply when you install the BlackBerry® Collaboration Service on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server® 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td>IBM® Lotus® Sametime®</td>
<td>IP address of the computer that hosts the BlackBerry Collaboration Service added to the CommunityConnectivity document on the IBM Lotus Sametime server</td>
</tr>
<tr>
<td>Novell® GroupWise® Messenger</td>
<td>SSL authentication turned on for the Novell GroupWise Messenger agents on the Novell GroupWise Messenger server</td>
</tr>
<tr>
<td>Microsoft® Office Live Communications Server 2005 or Microsoft® Office Communications Server 2007</td>
<td>The latest Microsoft hotfixes installed</td>
</tr>
</tbody>
</table>

**System requirements: BlackBerry MDS Connection Service**

The following system requirements apply when you install the BlackBerry® MDS Connection Service on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server® 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
</tbody>
</table>
### System requirements: BlackBerry MDS Integration Service

The following system requirements apply when you install the BlackBerry® MDS Integration Service on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server® 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
<tr>
<td>database conditions</td>
<td>A database server that also hosts the BlackBerry Configuration Database</td>
</tr>
<tr>
<td>static IP address</td>
<td>To support the BlackBerry MDS Integration Service pool, a static IP address for the computer</td>
</tr>
</tbody>
</table>

### System requirements: BlackBerry Monitoring Service

The following system requirements apply when you install the BlackBerry® Monitoring Service on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>operating system</td>
<td>Any of the following operating systems:</td>
</tr>
<tr>
<td></td>
<td>• Windows Server® 2003 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 R2 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 SP2 (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2</td>
</tr>
</tbody>
</table>
### System requirements: BlackBerry Router

To install the BlackBerry® Router on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server, any of the following operating systems:

- Windows Server® 2003 SP2 (32-bit or 64-bit)
- Windows Server 2003 R2 SP2 (32-bit or 64-bit)
- Windows Server 2008 SP2 (32-bit or 64-bit)
- Windows Server 2008 R2

### System requirements for your organization's environment

The following system requirements apply when you configure single sign-on authentication for the BlackBerry® Administration Service and BlackBerry® Web Desktop Manager or configure the BlackBerry MDS Connection Service to support Integrated Windows® authentication.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>network services</td>
<td>Microsoft® Active Directory® running at Windows Server® 2003 domain functional level or higher</td>
</tr>
<tr>
<td>application server</td>
<td>For the BlackBerry MDS Connection Service to support Integrated Windows authentication, Microsoft® IIS 6.0 or 7.0 using Integrated Windows® authentication</td>
</tr>
<tr>
<td>file server</td>
<td>For the BlackBerry MDS Connection Service to support Integrated Windows authentication, Windows Server 2003 file services or Windows Server 2008 file services</td>
</tr>
</tbody>
</table>
System requirements: Browsers for BlackBerry Web Desktop Manager, BlackBerry Administration Service, and BlackBerry Monitoring Service users

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>browser</td>
<td>• Windows® Internet Explorer® 7.0 to 8.0</td>
</tr>
<tr>
<td></td>
<td>• Mozilla® Firefox® 3.6</td>
</tr>
<tr>
<td></td>
<td>• Safari 4 for Mac</td>
</tr>
<tr>
<td></td>
<td>• Google Chrome™ 4</td>
</tr>
</tbody>
</table>

Windows Internet Explorer 7 or later provides optimal support for BlackBerry® Web Desktop Manager features and BlackBerry Administration Service features. Depending on the browser that you use, the BlackBerry Web Desktop Manager and BlackBerry Administration Service might not recognize BlackBerry devices and the browser might prevent you from activating devices that are connected to the computer, backing up and restoring device data, or adding or updating device applications.

<table>
<thead>
<tr>
<th>browser settings for Windows Internet Explorer</th>
<th>To support browser access, you must configure the following settings:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• language preferences configured to display encoded web pages</td>
</tr>
<tr>
<td></td>
<td>• Microsoft® hotfix 955839 installed on the users' computers to make sure the correct time zones are displayed</td>
</tr>
<tr>
<td></td>
<td>• the following settings turned on to support Microsoft® ActiveX®:</td>
</tr>
<tr>
<td></td>
<td>• Automatic prompting for Microsoft ActiveX controls</td>
</tr>
<tr>
<td></td>
<td>• Download signed Microsoft ActiveX controls</td>
</tr>
<tr>
<td></td>
<td>• Run Microsoft ActiveX controls and plug-ins</td>
</tr>
<tr>
<td></td>
<td>• Script Microsoft ActiveX controls marked safe for scripting</td>
</tr>
<tr>
<td></td>
<td>• support for JavaScript®</td>
</tr>
<tr>
<td></td>
<td>• cookies turned on</td>
</tr>
<tr>
<td></td>
<td>• support for TLS or SSL</td>
</tr>
<tr>
<td></td>
<td>• the SSL certificate installed to permit trusted connections to the BlackBerry Administration Service</td>
</tr>
<tr>
<td></td>
<td>• if using Windows Vista™, the BlackBerry Administration Service web address added as a trusted web site and Enable protected mode cleared</td>
</tr>
<tr>
<td>Item</td>
<td>Requirement</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
|      | - if you configure single sign-on authentication for the BlackBerry Administration Service  
|      |    - the BlackBerry Web Desktop Manager and BlackBerry Administration Service web sites assigned to the local intranet zone  
|      |    - Enable Integrated Windows Authentication selected  
|      | - if you do not configure single sign-on authentication for the BlackBerry Administration Service  
|      |    - the BlackBerry Web Desktop Manager, BlackBerry Administration Service, and BlackBerry Monitoring Service web sites assigned to the local intranet or trusted sites security zone  

**System requirements: Messaging server**

Any of the following messaging servers located in close proximity to where you want to install the primary BlackBerry® Enterprise Server:

- Microsoft® Exchange Server 2010 and Microsoft Exchange Server 2010 Update Rollup 1 (Microsoft Exchange Server MAPI Client and CDO 1.2.1 must be version 6.5.8147.0 or later to support Microsoft Exchange Server 2010)
- Microsoft Exchange Server 2007 SP2
- Microsoft Exchange Server 2003 SP2
- Microsoft® Exchange mixed environment (Microsoft Exchange Server 2003 and 2007 or Microsoft Exchange Server 2007 SP2 and 2010)

**System requirements: Firewall**

To install the BlackBerry® Enterprise Server, configure a firewall or proxy firewall with the following conditions:
• exclusive use of port 3101 to open and maintain an outbound, bidirectional TCP/IP connection to an external server
• support for resolving Internet addresses that use DNS
• for proxy firewalls, transparency of the proxy server

System requirements: Instant messaging server

To install the BlackBerry® Enterprise Server, any of the following instant messaging servers:
• IBM® Lotus® Sametime® 7.0 Community Server
• IBM Lotus Sametime 7.5 Community Server
• IBM Lotus Sametime 8.0 Community Server
• IBM Lotus Sametime 8.0.1 Community Server
• IBM Lotus Sametime 8.0.2 Community Server
• IBM Lotus Sametime 8.5 Community Server
• Microsoft® Office Live Communications Server 2005 SP1 Standard or Enterprise
• Microsoft® Office Communications Server 2007 Standard or Enterprise
• Novell® GroupWise® Messenger 2.0 or later

Supported features and environments

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>virtual environment</td>
<td>The BlackBerry® Enterprise Server and BlackBerry Enterprise Server components support VMware® Infrastructure 3.5 and 4.0 and Microsoft® Hyper-V® 2008.</td>
</tr>
<tr>
<td>SNMP monitoring</td>
<td>The BlackBerry Enterprise Server and BlackBerry Enterprise Server components support the SNMP service.</td>
</tr>
<tr>
<td>remote access</td>
<td>The BlackBerry Enterprise Server and BlackBerry Enterprise Server components support remote access by administrators who use Remote Desktop Connection.</td>
</tr>
</tbody>
</table>
## Unsupported environments

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMZ</td>
<td>The BlackBerry® Enterprise Server and BlackBerry Enterprise Server components, with the exception of the BlackBerry Router, do not support installation in a DMZ.</td>
</tr>
<tr>
<td>messaging server</td>
<td>The BlackBerry Enterprise Server and BlackBerry Enterprise Server components do not support installation on the computer that hosts the messaging server.</td>
</tr>
<tr>
<td>email application</td>
<td>The BlackBerry Enterprise Server and BlackBerry Enterprise Server components do not support installation on computers that host email applications.</td>
</tr>
<tr>
<td>instant messaging server</td>
<td>The BlackBerry Enterprise Server and BlackBerry Enterprise Server components do not support more than one type of instant messaging server in the BlackBerry Domain. For example, you cannot install the BlackBerry Collaboration Service for use with Microsoft® Office Communications Server 2007 and the BlackBerry Collaboration Service for IBM® Lotus® Sametime® in the same BlackBerry Domain.</td>
</tr>
<tr>
<td>IP</td>
<td>BlackBerry Enterprise Server components currently support only IPv4 and support for IPv6 will be available in future releases.</td>
</tr>
<tr>
<td>BlackBerry Attachment Service</td>
<td>If the BlackBerry Attachment Service is hosted on Windows Server® 2008, the BlackBerry Attachment Service does not support .mp3 audio files on BlackBerry devices, and the BlackBerry Attachment Service does not support any audio file formats on BlackBerry® 7100 Series devices that support CDMA networks. You must host the BlackBerry Attachment Service on Windows Server 2003 if you want the BlackBerry Attachment Service to support .mp3 audio files on devices and all audio formats on BlackBerry 7100 Series devices that support CDMA networks.</td>
</tr>
</tbody>
</table>
Preinstallation tasks

Configuring a Microsoft Exchange 2010 messaging environment

Create a Windows account that has a Microsoft Exchange 2010 mailbox

You must create a Windows® account with a Microsoft® Exchange 2010 mailbox so that the Windows account can authenticate with the Microsoft® Exchange Server.

Before you begin: If you want free/busy lookups to work in Microsoft® Outlook® 2003 and earlier, you must configure Microsoft Exchange 2010 to support Microsoft Outlook 2003 and earlier by creating a public folder database. For more information about supporting Microsoft Outlook 2003 and earlier, visit http://support.microsoft.com to read article 555851 and visit http://technet.microsoft.com to read articles 123694, 124270, 397221, and 691120.

1. On the computer that hosts Microsoft Exchange, log in using an administrator account that has the permission to create accounts.
2. Open the Microsoft Exchange Management Console.
3. Create an account and mailbox that you name BESAdmin.
4. To permit the BlackBerry® Enterprise Server to check if a BlackBerry device user has permission to access a public folder, assign the Owner permission for all public folders to the administrator account.

After you finish:
• To verify that you created the Windows account, log in to a computer using the Windows account.
• Verify that the Windows account is not a member of the Domain Administrators group in Microsoft® Active Directory®.
• Verify that BlackBerry device users have Read permissions and Visible permissions to public folders.
• To permit BlackBerry device users to check the availability of meeting participants using BlackBerry® Device Software 4.5 or later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit http://technet.microsoft.com to read articles 629523 and 691129.

Configure Microsoft Exchange 2010 permissions for the Windows account

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. Type `Get-MailboxDatabase | Add-ADPermission -User "BESAdmin" -AccessRights ExtendedRight -ExtendedRights Receive-As, ms-Exch-Store-Admin`.
3. Type `Add-RoleGroupMember "View-Only Organization Management" -Member "BESAdmin"`.
4. Do one of the following:
To set the permissions at the organizational unit level, type `Add-ADPermission -InheritedObjectType User -InheritanceType Descendants -ExtendedRights Send-As -User "BESAdmin" -Identity "OU=<organizational_unit>,DC=<domain_1>,DC=<domain_2>,DC=<domain_3>"` where `<domain_1>`, `<domain_2>`, and `<domain_3>` form the name of the domain. For example, if the organizational unit is Texas and the domain name is example.organization.net, type `Texas` for `<organizational_unit>`, `example` for `<domain_1>`, `organization` for `<domain_2>`, and `net` for `<domain_3>`.

To set the permissions at the common name level, type `Add-ADPermission -InheritedObjectType User -InheritanceType Descendants -ExtendedRights Send-As -User "BESAdmin" -Identity "CN=<common_name>,DC=<domain_1>,DC=<domain_2>,DC=<domain_3>"` where `<domain_1>`, `<domain_2>`, and `<domain_3>` form the name of the domain. For example, if the common name is Users and the domain name is example.organization.net, type `Users` for `<common_name>`, `example` for `<domain_1>`, `organization` for `<domain_2>`, and `net` for `<domain_3>`.

After you finish: If you create a new mailbox database for Microsoft Exchange, repeat step 2.

**Turn off client throttling in Microsoft Exchange 2010**

By default, Microsoft® Exchange 2010 uses client throttling policies to track the bandwidth that each Microsoft Exchange user consumes and enforce bandwidth limits, as necessary. The policies affect the performance of the BlackBerry® Enterprise Server negatively, so you should turn off client throttling for the Windows® account that has a Microsoft Exchange mailbox.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. Type `New-ThrottlingPolicy BESPolicy`.
3. Type `Set-ThrottlingPolicy BESPolicy -RCAMaxConcurrency $null`.
4. Type `Set-Mailbox "BESAdmin" -ThrottlingPolicy BESPolicy`.

**Increase the maximum number of connections to the Address Book service in Microsoft Exchange 2010**

By default, Microsoft® Exchange 2010 limits the maximum number of connections from the BlackBerry® Enterprise Server to the Address Book service to 50. To permit the BlackBerry Enterprise Server to run, you must increase the number of permitted connections to a large value (for example, 100,000).

1. On the computer that hosts the Microsoft Exchange CAS server, in `<drive>\Program Files\Microsoft\Exchange Server\V14\Bin`, in a text editor, open the `microsoft.exchange.addressbook.service.exe.config` file.
2. Change the value of the MaxSessionsPerUser key to **100000**.
3. Save and close the file.
4. Restart the Address Book service.
Configure a management role for Microsoft Exchange Web Services

If you want the BlackBerry® Enterprise Server to use Microsoft® Exchange Web Services to manage calendars on BlackBerry devices, you must configure a management role for Microsoft Exchange Web Services in Microsoft Exchange 2010.

For more information about configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services, see the BlackBerry Enterprise Server Administration Guide.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. Type `New-ManagementRoleAssignment -Name "BES Admin EWS" -Role ApplicationImpersonation -User "BESAdmin"`.

Configure the BlackBerry Enterprise Server to run without public folders

If you did not install any public folders in Microsoft® Exchange, you must configure the BlackBerry® Enterprise Server to run without public folders by changing a registry key.

1. On each computer that hosts the BlackBerry Enterprise Server, click **Start > Run**.
2. In the **Open** field, type `regedit`.
3. Click **OK**.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows®, navigate to `HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows Messaging Subsystem\CDO`.
   - If you are running a 64-bit version of Windows, navigate to `HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\Windows Messaging Subsystem`.
5. If the **CDO** registry key does not exist, create a registry key that you name **CDO**.
6. In the **CDO** registry key, if the DWORD value does not exist, create a DWORD value that you name **Ignore No PF**.
7. Change the DWORD value to **1**.
8. Click **OK**.

Permit meeting requests from outside of your organization when using Microsoft Exchange Web Services for Microsoft Exchange 2010

By default, the BlackBerry® Enterprise Server uses Microsoft® Exchange Web Services to manage calendars on BlackBerry devices. To permit BlackBerry device users to receive meeting requests from outside of your organization when using Microsoft Exchange Web Services, you must configure the calendar settings in Microsoft Exchange.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. For each Microsoft Exchange Server that hosts users, type `Get-Mailbox <messaging_server_name>|Set-CalendarProcessing -ProcessExternalMeetingMessages $true`. 
Configuring a Microsoft Exchange 2007 messaging environment

Create a Windows account that has a Microsoft Exchange 2007 mailbox

You must create a Windows® account that has a Microsoft® Exchange 2007 mailbox so that the Windows account can authenticate with the Microsoft® Exchange Server.

**Before you begin:** You must configure Microsoft Exchange 2007 to support versions of Microsoft® Outlook® that are earlier than 2007 by creating a public folder database. For more information about supporting versions of Microsoft Outlook that are earlier than 2007, visit [http://support.microsoft.com](http://support.microsoft.com) to read article 555851 and visit [http://technet.microsoft.com](http://technet.microsoft.com) to read articles 123694, 124270, 397221, and 691120.

1. On the computer that hosts Microsoft Exchange, log in using an administrator account that has the correct permission to create accounts.
2. Open the Microsoft Exchange Management Console.
3. Create an account and mailbox that you name **BESAdmin**.
4. To permit the BlackBerry® Enterprise Server to check if a user has permissions for a public folder, assign the Owner permission for all public folders to the administrator account.

**After you finish:**
- To verify that you created the Windows account, log in to a computer using the Windows account.
- Verify that the Windows account is not a member of the Domain Administrators group in Microsoft® Active Directory®.
- Verify that BlackBerry device users have Read and Visible permissions to public folders.
- To permit BlackBerry device users to check the availability of meeting participants in BlackBerry® Device Software 4.5 or later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit [http://technet.microsoft.com](http://technet.microsoft.com) to read articles 629523 and 691129.

Configure Microsoft Exchange 2007 permissions for the Windows account

1. On a computer that hosts the Microsoft® Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. Perform one of the following actions:
   - If you logged in to a Microsoft® Exchange Server 2007, type `add-exchangeadministrator "BESAdmin" -role ViewOnlyAdmin`.
   - If you logged in to another computer, type `get-mailboxserver "<messaging_server_name>" | add-exchangeadministrator "BESAdmin" -role ViewOnlyAdmin`.
3. For each Microsoft Exchange Server 2007 that hosts BlackBerry® device users, type the following command: `get-mailboxserver "<messaging_server_name>" | add-adpermission -user "BESAdmin" -accessrights ExtendedRight -extendedrights Receive-As, ms-Exch-Store-Admin`.
Permit BlackBerry device users to send email messages in a Microsoft Exchange environment

To permit BlackBerry® device users to send email messages, you must configure Send As permissions for the Microsoft® Active Directory® user object that contains BlackBerry device users. This task describes how to configure the Send As permissions for the entire Windows® domain but you can also configure the permissions at the user object level or on a container of user objects.

For more information about Send As permissions and the BlackBerry® Enterprise Server, visit www.blackberry.com/support to read KB04707. For more information about assigning Send As permissions permissions to multiple user accounts, visit www.support.microsoft.com to read article 912918.

1. Log in to a computer in the Windows® domain as an administrator that has permissions to modify user objects in Microsoft Active Directory.
3. On the View menu, click Advanced Features.
4. Right-click the domain root. Click Properties.
6. Click Add.
7. Type the name of the Windows account that you created (for example, BESAdmin).
8. Click Check Names.
9. Click OK.
10. In the Apply drop-down list, click User Objects.
11. In the Allow column, select the Send As check box.
12. Click Apply.
13. Click OK.

Permit meeting requests from outside of your organization when using Microsoft Exchange Web Services for Microsoft Exchange 2007

By default, the BlackBerry® Enterprise Server uses Microsoft® Exchange Web Services to manage calendars on BlackBerry devices. To permit BlackBerry device users to receive meeting requests from outside of your organization when using Microsoft Exchange Web Services, you must configure the calendar settings in Microsoft Exchange.

1. On a computer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management Shell.
2. For each Microsoft Exchange Server that hosts users, type Get-Mailbox messaging-server name Set-MailboxCalendarSettings -ProcessExternalMeetingMessages $true.
Configuring a Microsoft Exchange 2003 messaging environment

Create a Windows account that has a Microsoft Exchange 2003 mailbox

You must create a Windows® account that has a Microsoft® Exchange 2003 mailbox so that the Windows account can authenticate with the Microsoft Exchange messaging server.

1. On any computer in the Windows domain, on the taskbar, click Start > Programs > Microsoft Exchange > Active Directory Users and Computers.
2. Create an account that has the following attributes:
   - Name: BESAdmin
   - Group membership: Domain User
3. Create a Microsoft Exchange mailbox for the account.
4. To activate the new mailbox, send a test email message.

After you finish:

If you cannot see the Windows account in the Microsoft Active Directory to verify that you created it, log in to a computer using the Windows account.

For more information about the Send As permission and the BlackBerry® Enterprise Server, visit www.blackberry.com to read KB04707.

For more information about assigning the Send As permission to multiple user accounts, visit www.support.microsoft.com to read article 912918.

Configure Microsoft Exchange 2003 permissions for the Windows account

On each Microsoft® Exchange 2003 server that hosts BlackBerry® device users, you must configure Microsoft Exchange permissions for the Windows® account (for example, BESAdmin) that you want to use to install the BlackBerry® Enterprise Server components.

This task describes how to configure the Microsoft Exchange permissions at the administrative group level for every Microsoft Exchange 2003 server that hosts BlackBerry device users but you can also configure the permissions at other levels, such as at the root of the organization or another administrative group.

1. On the computer that hosts the Microsoft Exchange 2003 System Manager, open the Microsoft Exchange 2003 System Manager.
2. Configure the Exchange View Only Administrator permission for the Windows account in the administrative group that contains the Microsoft Exchange 2003 servers that host BlackBerry device users.
3. On each Microsoft Exchange 2003 server that hosts BlackBerry device users, assign the following permissions to the Windows account:
   • Send As
   • Receive As
   • Administer Information Store

4. To permit the BlackBerry Enterprise Server to check if users have permissions to access a public folder, assign the Owner permission for all public folders to the Windows account.

**After you finish:** Verify that the users have Read and Visible permissions to public folders.

---

**Permit BlackBerry device users to send email messages in a Microsoft Exchange environment**

To permit BlackBerry® device users to send email messages, you must configure Send As permissions for the Microsoft® Active Directory® user object that contains BlackBerry device users. This task describes how to configure the Send As permissions for the entire Windows® domain but you can also configure the permissions at the user object level or on a container of user objects.

For more information about Send As permissions and the BlackBerry® Enterprise Server, visit [www.blackberry.com/support](http://www.blackberry.com/support) to read KB04707. For more information about assigning Send As permissions permissions to multiple user accounts, visit [www.support.microsoft.com](http://www.support.microsoft.com) to read article 912918.

1. Log in to a computer in the Windows® domain as an administrator that has permissions to modify user objects in Microsoft Active Directory.
2. On the taskbar, click **Start > Administrative Tools > Active Directory Users and Computers**.
3. On the **View** menu, click **Advanced Features**.
4. Right-click the domain root. Click **Properties**.
5. On the **Security** tab, click **Advanced**.
6. Click **Add**.
7. Type the name of the Windows account that you created (for example, BESAdmin).
8. Click **Check Names**.
9. Click **OK**.
10. In the **Apply** drop-down list, click **User Objects**.
11. In the **Allow** column, select the **Send As** check box.
12. Click **Apply**.
13. Click **OK**.
Configure permissions for the Windows account

On each computer that you want to install the BlackBerry® Enterprise Server components on, you must configure permissions for the Windows® account that you want to use to install the BlackBerry Enterprise Server components and run the services for the BlackBerry Enterprise Server.

Without the correct permissions, the BlackBerry Enterprise Server cannot run.

1. Right-click **My Computer**. Click **Manage**.
2. In the left pane, expand **Local Users and Groups**.
3. Navigate to the **Groups** folder.
4. In the right pane, double-click **Administrators**.
5. Click **Add**.
6. In the **Enter the object names to select** field, type the Windows account name that you want the services for the BlackBerry Enterprise Server to use (for example, BESAdmin).
7. Click **OK**.
8. Click **Apply**.
9. Click **OK**.
10. On the taskbar, click **Start > Programs > Administrative Tools > Local Security Policy**.
11. Configure the following permissions for the Windows account:
   - log on locally with local permissions (if not assigned by default)
   - log on as a service
12. On the taskbar, click **Start > Programs > Administrative Tools > Computer Management**.
13. Add the Windows account to the local administrators group.

Permit BlackBerry device users to send email messages in a Microsoft Exchange environment

To permit BlackBerry® device users to send email messages, you must configure Send As permissions for the Microsoft® Active Directory® user object that contains BlackBerry device users. This task describes how to configure the Send As permissions for the entire Windows® domain but you can also configure the permissions at the user object level or on a container of user objects.

For more information about Send As permissions and the BlackBerry® Enterprise Server, visit www.blackberry.com/support to read KB04707. For more information about assigning Send As permissions permissions to multiple user accounts, visit www.support.microsoft.com to read article 912918.

1. Log in to a computer in the Windows® domain as an administrator that has permissions to modify user objects in Microsoft Active Directory.
3. On the View menu, click Advanced Features.
4. Right-click the domain root. Click Properties.
6. Click Add.
7. Type the name of the Windows account that you created (for example, BESAdmin).
8. Click Check Names.
9. Click OK.
10. In the Apply drop-down list, click User Objects.
11. In the Allow column, select the Send As check box.
12. Click Apply.
13. Click OK.

Prevent the Microsoft Exchange known issues for wireless calendar synchronization

Some known issues for Microsoft® Exchange impact how the BlackBerry® Enterprise Server synchronizes calendars over the wireless network. To prevent the known issues from occurring, you can read about the known issues for Microsoft Exchange that might impact your organization's messaging environment and install the hotfixes for them. If your organization's messaging environment includes multiple messaging servers, you can resolve the known issues that apply to the latest Microsoft Exchange software version in your organization's environment.

If you do not install the correct hotfixes, the BlackBerry Enterprise Server cannot run.

2. Verify that your organization's environment meets the requirements that are described in the applicable known issues.
3. Download the hotfixes for the known issues on the computers that you want to install the BlackBerry Enterprise Server or BlackBerry Administration Service on.
4. Install the hotfixes.
Verify if the Windows account can access a user account in Microsoft Exchange

The BlackBerry® Enterprise Server requires permission to access each BlackBerry device user's mailbox to process email messages. The IEMSText.exe tool runs a test to verify whether the Windows® account has the Send As permission in Microsoft® Exchange so that the BlackBerry Enterprise Server can access user accounts. The IEMSText.exe tool does not verify whether the BlackBerry Enterprise Server can send email messages on behalf of a BlackBerry device user.

1. Copy the BlackBerry® Enterprise Server installation files to the computer that you want to install the BlackBerry Enterprise Server on.
2. Extract the contents to a folder on the computer.
3. Navigate to \extracted_folder\Tools.
4. Double-click IEMSTest.exe.
5. In the Profile Name drop-down list, select the profile names for the user accounts.
6. Click OK.
7. In the left pane, select the user accounts that you want to check.
8. Click Select.
9. Click OK.

Configuring connections for the BlackBerry Enterprise Server databases

The BlackBerry® Enterprise Server, BlackBerry Monitoring Service, and BlackBerry MDS Integration Service store data in their own databases. The database for the BlackBerry Enterprise Server is the BlackBerry Configuration Database.

You create the BlackBerry Configuration Database when you install a BlackBerry Enterprise Server or BlackBerry Administration Service or when you run the CreateDB executable. You can create the BlackBerry MDS Integration Service database or BlackBerry Monitoring Service database during the installation processes for the BlackBerry MDS Integration Service or BlackBerry Monitoring Service, respectively.

The BlackBerry Enterprise Server, BlackBerry Monitoring Service, and BlackBerry MDS Integration Service can connect to their databases on the Microsoft® SQL Server® using Windows® authentication or database authentication. By default, the BlackBerry Enterprise Server, BlackBerry Monitoring Service, and BlackBerry MDS Integration Service log in to their databases using the Windows account that you use to complete the installation process or the database credentials you provided during the installation process.

To support database mirroring for the the BlackBerry Configuration Database or BlackBerry MDS Integration Service database with Microsoft SQL Server 2005 or Microsoft SQL Server 2008, you must use Windows authentication. The BlackBerry Monitoring Service does not support database mirroring.
Specifying permissions when you connect to the BlackBerry Enterprise Server databases using Windows authentication or Microsoft SQL Server authentication

If you connect the BlackBerry® Enterprise Server, BlackBerry MDS Integration Service, and BlackBerry Monitoring Service to the BlackBerry Enterprise Server databases using Windows® authentication or Microsoft® SQL Server® authentication during the BlackBerry Enterprise Server installation process, the Windows account or Microsoft SQL Server account that you specify must have database permissions on the database server. The type of permissions that you specify is determined by the setup option that you select and whether you create the BlackBerry Enterprise Server databases on the computer that hosts the BlackBerry Enterprise Server components or on another database server.

Specifying permissions for the Windows account or Microsoft SQL Server account

If you install Microsoft® SQL Server® 2005 Express during the BlackBerry® Enterprise Server installation process, you might need to specify permissions for the Windows® account or Microsoft SQL Server account, depending on the type of authentication you select.

When you select Windows authentication during the BlackBerry Enterprise Server installation process, the setup application automatically assigns the required permissions to the Windows account that you use to complete the installation process.

When you select Microsoft SQL Server authentication during the BlackBerry Enterprise Server installation process, you must assign the required database permissions to the Microsoft SQL Server account that you use to complete the installation process.

Assign permissions to the Windows account or Microsoft SQL Server account

Perform one of the following actions:

- If you create the BlackBerry® Enterprise Server databases on the computer that hosts the BlackBerry Enterprise Server and you require the setup application to install Microsoft® SQL Server® Express during the installation process and you choose Windows® authentication, you are not required to assign Microsoft SQL Server permissions to the Windows account. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account.

- If you create the BlackBerry Enterprise Server databases on the computer that hosts the BlackBerry Enterprise Server and you require the setup application to install Microsoft SQL Server Express during the installation process and you choose Microsoft SQL Server authentication, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Microsoft SQL Server account. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Microsoft SQL Server account.

- If you create the BlackBerry Enterprise Server databases on the computer that hosts the BlackBerry Enterprise Server and the computer already hosts a Microsoft SQL Server, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Windows account or Microsoft SQL Server account that you use to complete the
BlackBerry Enterprise Server installation process. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account or Microsoft SQL Server account.

- If you create the BlackBerry Enterprise Server databases on a computer that does not host the BlackBerry Enterprise Server, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Windows or Microsoft SQL Server account that you use to complete the BlackBerry Enterprise Server installation process. If you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account or Microsoft SQL Server account.

Configuring authentication to the BlackBerry MDS Integration Service database

When the setup application creates the BlackBerry® MDS Integration Service database during the installation process, you must use the same authentication method and account that you specified for the BlackBerry Configuration Database. The BlackBerry MDS Integration Service requires the same permissions to access the BlackBerry MDS Integration Service database that the BlackBerry® Enterprise Server requires to access the BlackBerry Configuration Database.

Create a BlackBerry Configuration Database

If the security required by your organization does not allow applications to have permissions to create or upgrade databases, you can run the CreateDB executable on the database server to create the BlackBerry® Configuration Database instead of using the setup application. After you create or upgrade the BlackBerry Configuration Database using the CreateDB executable, you can run the setup application using a Windows® account with minimum requirements to the database server.

**Before you begin:** Verify that the appropriate permissions are configured on the database server.

1. Log in to the computer that hosts the database server using a local administrator account or a Windows account that has SQL administrator permissions.
2. Copy the BlackBerry® Enterprise Server installation media to the database server that you want to configure as the host server for the BlackBerry Configuration Database.
3. Extract the contents to a folder on the computer.
4. Navigate to `<extracted_folder>\Database`.
5. Open the BesMgmt.cfg file in a text editor.
6. Change the file to include information that is specific to your organization's environment.
7. Save and close the file.
8. Open a command prompt window.
9. Change to `<extracted_folder>\Database`.
10. Type `CreateDB.exe BESMgmt.cfg`.
# BESMgmt.cfg properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATABASE_NAME</td>
<td>This property specifies the name of the BlackBerry® Configuration Database.</td>
</tr>
<tr>
<td>CMD</td>
<td>This property specifies the type of action that the CreateDB executable must complete (for example, whether to install or upgrade the BlackBerry Configuration Database).</td>
</tr>
<tr>
<td>USERID</td>
<td>If you use database authentication, this property specifies the user name of the database account that has server administrator permission and database creator permission.</td>
</tr>
<tr>
<td>PASSWORD</td>
<td>If you use database authentication, this property specifies the password for the database account.</td>
</tr>
<tr>
<td>SCRIPT_ROOT</td>
<td>This property specifies the path to the DBInstallScripts folder. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>LOG_DIR</td>
<td>This property specifies the path to the folder that you want to create log files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>DBMS</td>
<td>This property specifies the database management system that your organization uses.</td>
</tr>
<tr>
<td>DB_FILE_DIR</td>
<td>This property specifies an existing folder that you want to save the database files in. By default, this folder is in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
<tr>
<td>BACKUP_DIR</td>
<td>This property specifies an existing folder where you want to save the database backup in. By default, this folder is located in the same root folder that the CreateDB.exe file is located in.</td>
</tr>
</tbody>
</table>
Install the SNMP service for monitoring by the BlackBerry Monitoring Service

If you want to install the BlackBerry® Monitoring Service on a computer in the BlackBerry Domain, you must install the SNMP service on each computer that you want to install the BlackBerry® Enterprise Server on so that the BlackBerry Monitoring Service can monitor the BlackBerry Enterprise Server activity.

Before you begin: Verify that each computer can access the Windows® installation media.

1. On the taskbar, click Start > Settings > Control Panel > Add/Remove Programs > Add/Remove Windows Components.
4. Click OK.
5. When Windows Setup prompts you, install the files from the Windows installation media.
6. Complete the installation wizard.
7. In the Windows Services, verify that the SNMP service is running.

After you finish: To complete the SNMP service installation process, after you install the BlackBerry Enterprise Server or BlackBerry Enterprise Server components, configure the SNMP service to monitor the activity of the BlackBerry Enterprise Server or BlackBerry Enterprise Server components.

Creating a BlackBerry Administration Service pool using DNS round robin that includes the BlackBerry Web Desktop Manager

When you install the BlackBerry® Administration Service, BlackBerry® Web Desktop Manager, or both, the setup application installs the BlackBerry Administration Service services automatically. The BlackBerry Administration Service and BlackBerry Web Desktop Manager require the BlackBerry Administration Service services to run.

If you create a BlackBerry Administration Service pool using DNS round robin, you can install the BlackBerry Administration Service and BlackBerry Web Desktop Manager on each computer in the pool or you can install the BlackBerry Administration Service or BlackBerry Web Desktop Manager on some of the computers in the pool. If you install the BlackBerry Administration Service and BlackBerry Web Desktop Manager on each computer in the pool, you can use the pool name that you specified during the installation process in the URLs for the BlackBerry Administration Service and BlackBerry Web Desktop Manager (for example, https://<pool_name>/webconsole/login or https://<pool_name>/webdesktop/login).

If you do not install both components on each computer in the pool and you try to access one of the URLs using the pool name, the web browser might display an HTTP 404 error message. The HTTP 404 error message occurs when the web browser tries to connect to a computer in the pool that you did not install the component on that you are trying to access. For example, you can install the BlackBerry Administration Service on two of the computers in the pool and the BlackBerry Web Desktop Manager on two other computers in the pool.
To make sure that the web browser does not display HTTP 404 error messages, you can choose one of the following options:

- You can create separate pools within the BlackBerry Administration Service pool for the BlackBerry Administration Service and the BlackBerry Web Desktop Manager. You can provide your organization's administrators and BlackBerry device users with URLs that include the specific pool names.
- You can provide administrators and users in your organization's environment with URLs that include the FQDNs of the computers that you installed the BlackBerry Administration Service or BlackBerry Web Desktop Manager on (for example, https://<FQDN_of_computer>/webconsole/login or https://<FQDN_of_computer>/webdesktop/login).

Creating a BlackBerry MDS Integration Service pool

You can create a BlackBerry® MDS Integration Service pool using the setup application during the installation processes for the BlackBerry MDS Integration Service instances that you want to include in the pool. During the installation process for the first BlackBerry MDS Integration Service instance, you must type a unique FQDN or DNS name that identifies the pool. During the installation processes for the subsequent BlackBerry MDS Integration Service instances, you must select the existing pool name from the list so that you can add the instances to the pool. After you complete the installation processes, BlackBerry MDS Integration Service clients can access the BlackBerry MDS Integration Service instances in the pool using the unique DNS name.

Create the DNS record for a BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance

To configure multiple BlackBerry® Administration Service instances or BlackBerry MDS Integration Service instances for high availability using DNS round robin, you must create a DNS record. The DNS record permits the clients of the BlackBerry Administration Service pool or BlackBerry MDS Integration Service pool to access the instances using a single DNS name. You must create the DNS record in the same domain as the computers that host the BlackBerry Administration Service instances or BlackBerry MDS Integration Service instances.

Before you begin:

- You must configure a static IP address for each computer that you want to install a BlackBerry MDS Integration Service instance or BlackBerry Administration Service instance on.
- You must have permission to manage the DNS.
- If you configure DNS round robin, you must configure clients to resolve the DNS name into a list of IP addresses and distribute traffic equally across the BlackBerry Administration Service or BlackBerry MDS Integration Service instances in the pool.

1. Log in to the DNS server.
2. In the DNS management console, access the forward lookup zone that you want to add the BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance to.
3. To create a new host, type the following information:
• In the **Name** field, type the name of the BlackBerry Administration Service pool or BlackBerry MDS Integration Service pool that you want to use.
• In the **IP Address1** field, type the IP address of the computer that you want to host a BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance on.
• Select the **Create associated pointer (PTR) record** check box.

4. Repeat step 3 for each BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance that you want to install. When you add entries to the same pool, you must use the same pool name for all BlackBerry Administration Service instances or BlackBerry MDS Integration Service instances.

**After you finish:** To remove a BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance from a pool, delete the entry for the IP address of the BlackBerry Administration Service instance or BlackBerry MDS Integration Service instance from the DNS server.

---

**Persistent socket connections for the BlackBerry Collaboration Service**

<table>
<thead>
<tr>
<th>Instant messaging environment</th>
<th>BlackBerry Collaboration Service requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® Office Live Communications Server 2005 or Microsoft® Office Communications Server 2007, and TLS communication protocol</td>
<td>one persistent socket connection for each instant messaging session</td>
</tr>
<tr>
<td>Microsoft Office Live Communications Server 2005 or Microsoft Office Communications Server 2007, and TCP communication protocol</td>
<td>three persistent socket connections for each instant messaging session</td>
</tr>
<tr>
<td>Microsoft Office Live Communications Server 2005 or Microsoft Office Communications Server 2007, and HTTPS communication protocol</td>
<td>one persistent socket connection and multiple sequential socket connections for each instant messaging session</td>
</tr>
<tr>
<td>IBM® Lotus® Sametime®</td>
<td>three persistent socket connections to create one TCP connection; all instant messaging sessions use that TCP connection</td>
</tr>
<tr>
<td>Novell® GroupWise® Messenger</td>
<td>one persistent socket connection for each instant messaging session</td>
</tr>
</tbody>
</table>
Applications that are installed with the BlackBerry Enterprise Server components

The BlackBerry® Enterprise Server installation process can include the installation of third-party applications.

<table>
<thead>
<tr>
<th>Application</th>
<th>BlackBerry Enterprise Server components that the application is installed with</th>
</tr>
</thead>
</table>
| JDK with JRE™ version 1.6.15                     | • BlackBerry Administration Service  
• BlackBerry Monitoring Service                        |
| JDK version 1.6.15                               | • BlackBerry Administration Service  
• BlackBerry Collaboration Service  
• BlackBerry MDS Connection Service  
• BlackBerry MDS Integration Service               |
| Microsoft® XML Parser version 6.0 SP2            | all components except the BlackBerry Router                                                                   |
| Microsoft® SQL Server® 2005 Express Edition SP3 (if selected) | • BlackBerry Administration Service  
• any other components                              |
| Microsoft® .NET Framework version 2.0 (if you are installing Microsoft SQL Server Express) | • All components                                                                                         |
Installing the BlackBerry Enterprise Server software

Prerequisites: Installing the BlackBerry Enterprise Server software

- Verify that the Windows® account that you use to install the BlackBerry® Enterprise Server software is assigned the local administrator permission on the computer that you perform the installation process on.
- Verify that the Windows account that you want to use to install the BlackBerry Enterprise Server software is not a member of the Domain Admins group in Microsoft® Active Directory®.
- In a Microsoft® Exchange 2003 environment, to start the MAPI subsystem, open the Microsoft Exchange System Manager.
- If your organization's domain controllers are running on Windows Server® 2008, verify that the number of NSPI connections that the BlackBerry Enterprise Server can make to the Microsoft® Exchange Server meets the requirements of your organization. For more information, visit www.blackberry.com/support to read KB17325 and visit http://support.microsoft.com to read KB949469.
- Retrieve the following information:
  - BlackBerry® CAL key
  - SRP host (in BlackBerry Enterprise Server version 5.0 and later, the format of the SRP host is different from earlier versions)
  - SRP identifier
  - SRP key
  - computer name and port number of the instant messaging server (use the virtual server name and port number where the AJAX Service is installed, if applicable)
  - computer name and port number of the proxy server (if applicable)
- Add the blackberry.net domain to the permitted lists in the antivirus application or anti-spam application that the messaging server or gateway uses.
- Verify that the computer has access to www.blackberry.com (optional).
- If your organization uses a proxy server for Internet access, get the credentials for the proxy server.
- Verify that you installed the appropriate languages and text services on the computer that you use to install the BlackBerry Enterprise Server.
- If you want to install Microsoft® SQL Server® 2005 Express Edition SP3 on a computer that does not host any BlackBerry Enterprise Server components, you can navigate to the Tools folder in the BlackBerry Enterprise Server installation files and run Sqlexpr.exe.
- If you are installing the BlackBerry Administration Service, verify that the computers that host the BlackBerry Administration Service and BlackBerry Configuration Database are not separated by a WAN bridge.
- If you are performing the installation on a computer that has more than one NIC, verify that the production NIC is first in the bind order in the Windows network settings.

Install the BlackBerry Enterprise Server software

During the BlackBerry® Enterprise Server installation process, you must restart the computer.
To administer the BlackBerry Enterprise Server, you must install the BlackBerry Administration Service. You can install the BlackBerry Administration Service on the computer that hosts the BlackBerry Enterprise Server or on a separate computer. You must install the BlackBerry Administration Service if you create a BlackBerry Configuration Database and you must also either install or upgrade the BlackBerry Administration Service on the computer that you perform the installation process on in the BlackBerry Domain first.

1. Log in to the computer that you want to install the BlackBerry Enterprise Server on using the Windows® account that you created and that has correct permissions. This account runs the BlackBerry Enterprise Server services.
2. In the BlackBerry Enterprise Server installation files, double-click setup.exe. If your operating system is Windows Server® 2008, run setup.exe as an administrator.
3. In the Setup type dialog box, select one of the following options:
   - If this installation process is the first installation of BlackBerry Enterprise Server software in a BlackBerry Domain, select Create a BlackBerry Configuration Database.
   - For all other installations of the BlackBerry Enterprise Server software, select Use an existing BlackBerry Configuration Database.
4. In the Setup options dialog box, you can select or remove BlackBerry Enterprise Server components from the Additional Components list.
5. In the Accounts and Folders dialog box, in the Name field, type the name of the BlackBerry Enterprise Server that you want the BlackBerry Administration Service to display.
6. When the setup application prompts you to restart the computer, click Yes.
7. Log in to the computer that you want to install the BlackBerry Enterprise Server on using the same account that you used in step 1.
8. In the Database information dialog box, if you configured the database server to use static ports, select the Static option. If the static port number is not 1433, type the port number in the Port field.
9. In the Database mirroring options dialog box, if you want to configure database mirroring, select the Add support for database mirroring check box and type the name of the database server that hosts the mirror database in the Name of the mirror database server field. The setup application does not create the BlackBerry Configuration Database on the mirror Microsoft® SQL Server®; it adds a registry key to the computer that includes the name of the mirror Microsoft SQL Server.
10. In the Microsoft Exchange Server dialog box, perform the following actions:
    a. In the Microsoft Exchange server field, type the name of the Microsoft® Exchange server.
    b. In the Mailbox field, type the name of the administrator that has the appropriate permissions.
    c. Click Check Name.
    d. Click Apply.
    e. Click OK.
11. In the Application extensibility settings dialog box, consider the following information:
    - You can type an FQDN to create a new BlackBerry MDS Integration Service pool or add the BlackBerry MDS Integration Service instance to a pool that you created during a previous installation process.
• To configure a hardware load-balancer for the BlackBerry MDS Integration Service pool, you can type an FQDN that corresponds to a DNS record in the DNS server that maps the FQDN to the IP address of the virtual server that you configured on the hardware load-balancer.

• The setup application creates the BlackBerry MDS Integration Service database on the database server that hosts the BlackBerry Configuration Database.

• If you add the BlackBerry MDS Integration Service instance to an existing pool, the setup application selects the existing BlackBerry MDS Integration Service database and existing administrator account and publisher account.

12. In the Administration settings dialog box, perform the following actions:
   • In the Pool name field, type an FQDN that the setup application can use to create the BlackBerry Administration Service web address. If you install only one BlackBerry Administration Service instance in the BlackBerry Domain, you can accept the default pool name. If you install more than one BlackBerry Administration Service instance in the BlackBerry Domain, you must create a DNS entry for the pool name that is not the name of a computer and is mapped to the IP address of each BlackBerry Administration Service instance.
   • In the New password and Confirm password fields, type the password for the SSL certificate that the BlackBerry Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry Administration Service instance in the BlackBerry Domain.

13. In the Microsoft® Active Directory® settings dialog box, in the User password field, type the password for the Microsoft Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server uses to authenticate to Microsoft Active Directory. If you want to specify a different user name and user domain, you must make sure that the user domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.
   If the setup application cannot locate any of the global catalog servers that are associated with the Microsoft Active Directory account after you click the Next button, you must choose the global catalog servers that you want to add to the list manually. To add a global catalog server to the list, click the Add button and select the appropriate server. Each global catalog server that you add to the list must belong to the same domain as the Microsoft Active Directory user account.

14. Start the services for the BlackBerry Enterprise Server. If you installed the BlackBerry Administration Service, the setup application waits until the BlackBerry Administration Service services are running before the setup application continues.

15. In the Console addresses dialog box, copy the web addresses for the BlackBerry Enterprise Server components and paste them into a document for future reference. You can use the web addresses to log in to the BlackBerry Enterprise Server components that you installed.

After you finish:
• If required, add the name of the BlackBerry MDS Integration Service pool to the DNS server and change the name of the computer.
• To verify that the BlackBerry Configuration Database on a Microsoft SQL Server uses the appropriate collation setting, check that the collation setting for the BlackBerry Configuration Database is default case-insensitive.
• If you reinstalled the BlackBerry Administration Service, in Windows® Internet Explorer®, delete the cache.
Specifying a name for the BlackBerry Administration Service pool during the installation process

During the installation process, the setup application prompts you to specify the name of the BlackBerry® Administration Service pool.

The BlackBerry Administration Service instances use the pool name for interprocess communication and when you configure BlackBerry Administration Service high availability using DNS round robin. You must specify a valid DNS host name during the installation process, even if you do not configure BlackBerry Administration Service high availability using DNS round robin.

The setup application uses the FQDN of the computer that you install the first BlackBerry Administration Service instance on as the default value for the pool name. If you keep the default value and configure BlackBerry Administration Service high availability using DNS round robin at a later time, you must use the BlackBerry Configuration Panel to change the pool name to the host name for the pool.

The name for the BlackBerry Administration Service pool does not impact BlackBerry Administration Service high availability that uses a hardware load balancer.

For more information about BlackBerry Administration Service high availability, see the BlackBerry Enterprise Server Planning Guide.

Install a BlackBerry Enterprise Server component on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server

Before you begin:
- Install a BlackBerry® Enterprise Server and the BlackBerry Administration Service in your organization’s environment.
- Verify that the BlackBerry Administration Service is running on a Windows® account that has permission to access and modify the Windows registry on the computer that you want to install the BlackBerry Enterprise Server component on.

1. Using the Windows account that you created, log in to the computer that is separate from the computer that hosts the BlackBerry Enterprise Server. This account runs the services for the BlackBerry Enterprise Server components.
2. In the BlackBerry Enterprise Server installation files, double-click setup.exe. If your operating system is Windows Server® 2008, run setup.exe as an administrator.
3. In the Setup type dialog box, select Use an existing BlackBerry Configuration Database.
4. In the Database information dialog box, perform the following actions:
   - Type the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server uses.
   - If you configured the database server to use static ports, select the Static option. If the static port number is not 1433, in the Port field, type the port number.
5. In the **Database mirroring options** dialog box, if you want to configure database mirroring, select the **Add support for database mirroring** check box and type the name of the database server that hosts the mirror database in the **Name of the mirror database server** field. The setup application does not create the BlackBerry Configuration Database on the mirror Microsoft® SQL Server®; it adds a registry key to the computer that contains the name of the mirror Microsoft SQL Server.

6. In the **Setup options** dialog box, select or remove BlackBerry Enterprise Server components from the **Additional Components** list.

7. In the **Microsoft Exchange Server** dialog box, perform the following actions:
   a. In the **Microsoft Exchange server** field, type the name of the Microsoft® Exchange server.
   b. In the **Mailbox** field, type the name of the administrator that is assigned the appropriate permissions.
   c. Click **Check Name**.
   d. Click **Apply**.
   e. Click **OK**.

8. When the setup application prompts you to restart the computer, click **Yes**.

9. Log in to the computer that is separate from the computer that hosts the BlackBerry Enterprise Server using the same account that you used in step 1.

10. In the **Application extensibility settings** dialog box, consider the following information:
    • You can type a valid FQDN or IP address to create a BlackBerry MDS Integration Service pool or add the BlackBerry MDS Integration Service instance to a pool that you created during a previous installation process.
    • The setup application creates the BlackBerry MDS Integration Service database on the database server that hosts the BlackBerry Configuration Database.
    • If you add the BlackBerry MDS Integration Service instance to an existing pool, the setup application selects the existing BlackBerry MDS Integration Service database and the existing administrator account and publisher account.

11. In the **Administration settings** dialog box, perform the following actions:
    • In the **Pool name** field, type an FQDN that the setup application can use to create the BlackBerry Administration Service web address. If you install only one BlackBerry Administration Service instance in the BlackBerry Domain, you can accept the default pool name. If you install more than one BlackBerry Administration Service instance in the BlackBerry Domain, you must create a DNS entry for the pool name that is not the name of a computer and is mapped to the IP address of each BlackBerry Administration Service instance.
    • In the **New password** and **Confirm password** fields, type the password for the SSL certificate that the BlackBerry Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry Administration Service instance in the BlackBerry Domain.

12. In the **Microsoft® Active Directory® settings** dialog box, in the **User password** field, type the password for the Microsoft Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server uses to authenticate to Microsoft Active Directory. If you want to specify a different user name and user domain, you must make sure that the user domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.
If, after you click the Next button, the setup application cannot locate any of the global catalog servers that are associated with the Microsoft Active Directory account, you must choose the global catalog servers that you want to add to the list manually. To add a global catalog server to the list, click the Add button and select the appropriate server. Each global catalog server that you add to the list must belong to the same domain as the Microsoft Active Directory user account.

13. In the Start services dialog box, start the services for the BlackBerry Enterprise Server components.

14. In the Console addresses dialog box, copy the web addresses for the BlackBerry Enterprise Server components and paste them into a document for future reference. You can use the web addresses to log in to the BlackBerry Enterprise Server components.

After you finish:
- If required, add the name of the BlackBerry MDS Integration Service pool to the DNS server, and change the name of the computer.
- To view the BlackBerry Enterprise Server component in the BlackBerry Administration Service, restart the BlackBerry Administration Service.
- If you reinstalled the BlackBerry Administration Service, in Windows® Internet Explorer®, delete the cache.

Install a standalone BlackBerry Router

A standalone BlackBerry® Router is a BlackBerry Router that is hosted by a computer that does not host any other BlackBerry® Enterprise Server components except the BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Router and restarts the BlackBerry Router if it stops responding.

**Note:** You cannot manage the BlackBerry Controller that monitors a standalone BlackBerry Router in the BlackBerry Administration Service. You must manage the BlackBerry Controller in the BlackBerry Configuration Panel on the computer that hosts the standalone BlackBerry Router.

1. Log in to the computer using the Windows® account that you want to use to run the BlackBerry Router.
2. In the BlackBerry Enterprise Server installation files, double-click Setup.exe. If your operating system is Windows Server® 2008, run setup.exe as an administrator.
3. In the Setup type dialog box, select Install a standalone BlackBerry Router.
4. Start the services for the BlackBerry Router.

Install the BlackBerry Monitoring Service software

You can install the BlackBerry® Monitoring Service so that you can monitor BlackBerry® Enterprise Server activity and BlackBerry device user activity.

You can complete the following steps if you want to install the BlackBerry Monitoring Service on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server.

During the BlackBerry Enterprise Server installation process, you must restart the computer.

**Before you begin:** Install a BlackBerry Enterprise Server and a BlackBerry Administration Service.
1. Log in to the computer using the Windows® account that you want to use to run the BlackBerry Monitoring Service services.
2. In the Setup type dialog box, select Use an existing BlackBerry Configuration Database.
3. In the Database information dialog box, perform the following actions:
   • Type the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server uses.
   • If you configured the database server to use static ports, select the Static option. If the static port number is not 1433, in the Port field, type the port number.
4. In the Setup options dialog box, select Remote component and BlackBerry Monitoring Service.
5. When the setup application prompts you to restart the computer, click Yes.
6. In the Monitoring service dialog box, perform the following actions:
   • If there are a large number of BlackBerry device users in your organization or if you create a large number of reports in the BlackBerry Monitoring Service, install the BlackBerry Monitoring Service database on a database server that is separate from the database server that hosts the BlackBerry Configuration Database.
   • Type the names of the database server and BlackBerry Monitoring Service database.
7. Start the BlackBerry Monitoring Service services.
8. In the Console addresses dialog box, copy the BlackBerry Monitoring Service web address. You can use this web address to log in to the BlackBerry Monitoring Service.
Installing a standby BlackBerry Enterprise Server

To configure the BlackBerry® Enterprise Server for high availability and disaster recovery, you install a standby BlackBerry Enterprise Server on a separate computer from your organization's primary BlackBerry Enterprise Server. During the installation process, you assign a standby BlackBerry Enterprise Server to a primary BlackBerry Enterprise Server. You can assign only one standby BlackBerry Enterprise Server to each primary BlackBerry Enterprise Server. The setup application assigns the SRP credentials of the primary BlackBerry Enterprise Server to the standby BlackBerry Enterprise Server automatically.

When you install a standby BlackBerry Enterprise Server, you can install the same BlackBerry Enterprise Server components that are installed on the primary BlackBerry Enterprise Server, or different components. For example, you might want to install additional components with the standby BlackBerry Enterprise Server if you want to use the system resources on the computer to distribute the performance load.

You cannot change a primary BlackBerry Enterprise Server to a standby BlackBerry Enterprise Server by running the setup application again.

By default, the standby BlackBerry Enterprise Server enables you to fail over the following components if they stop responding on the primary BlackBerry Enterprise Server:

- BlackBerry Attachment Service
- BlackBerry Collaboration Service
- BlackBerry Dispatcher
- BlackBerry MDS Connection Service
- BlackBerry Messaging Agent
- BlackBerry Policy Service
- BlackBerry Router
- BlackBerry Synchronization Service

After you complete the installation process, the setup application does not start all the services for the standby BlackBerry Enterprise Server components. For example, the setup application does not start the BlackBerry Mail Store Service, BlackBerry Synchronization Service, or BlackBerry Policy Service. The failover process starts the services when the standby BlackBerry Enterprise Server promotes itself.

For more information about high availability in a large-scale environment, see the BlackBerry Enterprise Server Planning Guide.

Install a standby BlackBerry Enterprise Server

During the installation process, you must restart the computer.

**Before you begin:**

- Install a primary BlackBerry® Enterprise Server.
Verify that the BlackBerry Administration Service is running on a Windows® account that has permission to access and modify the Windows registry on the computer that you want to install the standby BlackBerry Enterprise Server on.

1. Log in to the computer using the Windows account that you used to install the primary BlackBerry Enterprise Server. This account runs the services for the standby BlackBerry Enterprise Server.
2. In the BlackBerry Enterprise Server installation files, double-click setup.exe. If your operating system is Windows Server® 2008, run setup.exe as an administrator.
3. In the Setup type dialog box, select Use an existing BlackBerry Configuration Database.
4. In the Database information dialog box, perform the following actions:
   - Type the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server uses.
   - If you configured the database server to use static ports, select the Static option. If the static port number is not 1433, type the port number in the Port field.
5. In the Database mirroring options dialog box, if you want to configure database mirroring, select the Add support for database mirroring check box and type the name of the database server that hosts the mirror database in the Name of the mirror database server field. The setup application does not create the BlackBerry Configuration Database on the mirror Microsoft® SQL Server®; it adds a registry key to the computer that includes the name of the mirror Microsoft SQL Server.
6. In the Microsoft Exchange Server dialog box, perform the following actions:
   a. In the Microsoft Exchange server field, type the name of the Microsoft® Exchange server.
   b. In the Mailbox field, type the name of the administrator that has the appropriate permissions.
   c. Click Check Name.
   d. Click Apply.
   e. Click OK.
7. In the Setup options dialog box, perform the following actions:
   - Click Install a standby BlackBerry Enterprise Server to set up high availability.
   - In the Additional components list, select any components that you want to install with the standby BlackBerry Enterprise Server.
8. In the High availability settings dialog box, select the primary BlackBerry Enterprise Server that you want to assign the standby BlackBerry Enterprise Server to.
9. When the setup application prompts you to restart the computer, click Yes.
10. Log in to the computer using the same account that you used in step 1. The setup application continues the installation process automatically.
11. In the Application extensibility settings dialog box, consider the following information:
   - You can type an FQDN to create a new BlackBerry MDS Integration Service pool or add the BlackBerry MDS Integration Service instance to a pool that you created during a previous installation process.
• To configure a hardware load balancer for the BlackBerry MDS Integration Service pool, you can type an FQDN that corresponds to a DNS record in the DNS server that maps the FQDN to the IP address of the virtual server that you configured on the hardware load balancer.

• The setup application creates the BlackBerry MDS Integration Service database on the database server that hosts the BlackBerry Configuration Database.

• If you add the BlackBerry MDS Integration Service instance to an existing pool, the setup application selects the existing BlackBerry MDS Integration Service database and existing administrator account and publisher account.

12. In the **Administration settings** dialog box, perform the following actions:

• In the **Pool name** field, type an FQDN that the setup application can use to create the BlackBerry Administration Service web address. If you install only one BlackBerry Administration Service instance in the BlackBerry Domain, you can accept the default pool name. If you install more than one BlackBerry Administration Service instance in the BlackBerry Domain, you must create a DNS entry for the pool name that is not the name of a computer and is mapped to the IP address of each BlackBerry Administration Service instance.

• In the **New password** and **Confirm password** fields, type the password for the SSL certificate that the BlackBerry Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry Administration Service instance in the BlackBerry Domain.

13. In the **Microsoft® Active Directory® settings** dialog box, in the **User password** field, type the password for the Microsoft Active Directory account (for example, BESAdmin) that the standby BlackBerry Enterprise Server uses to authenticate to Microsoft Active Directory. If you want to specify a different user name and user domain, you must make sure that the user domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

If the setup application cannot locate any of the global catalog servers that are associated with the Microsoft Active Directory account after you click the **Next** button, you must choose the global catalog servers that you want to add to the list manually. To add a global catalog server to the list, click the **Add** button and select the appropriate server. Each global catalog server that you add to the list must belong to the same domain as the Microsoft Active Directory user account.

14. Start the services for the standby BlackBerry Enterprise Server.

15. In the **Console addresses** dialog box, copy the BlackBerry Administration Service web address and paste it into a document for future reference. You can use the web address to log in to the BlackBerry Administration Service.

**After you finish:**

• As required, add the name of the BlackBerry MDS Integration Service pool to the DNS server and change the name of the computer.

• To view the standby BlackBerry Enterprise Server information in the BlackBerry Administration Service, restart the BlackBerry Administration Service on every computer that it is installed on in the BlackBerry Domain.

• If you reinstalled the BlackBerry Administration Service, in Windows® Internet Explorer®, delete the cache contents.
Postinstallation tasks

Test the BlackBerry Enterprise Server installation

1. In the Windows® Services, verify that the services for the BlackBerry® Enterprise Server are running.
2. In the Windows Event Viewer and log files that are located in `<drive>:\Program Files\Research In Motion\BlackBerry Enterprise Server\Logs`, check for error messages.
3. In the BlackBerry Administration Service, add a test user account.
   If you can add a test user account, the connection from the BlackBerry Enterprise Server to the BlackBerry Configuration Database and the messaging server is open.
4. If you installed the BlackBerry MDS Connection Service, browse to http://<BES_host>:8080.
   If the status page appears, the BlackBerry MDS Connection Service is running.

After you finish: For troubleshooting information, visit www.blackberry.com/support.

Install the BlackBerry database notification system

The BlackBerry® database notification system is designed to reduce the number of database queries that a BlackBerry® Enterprise Server makes to the BlackBerry Configuration Database.

If you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server, the BlackBerry database notification system installs automatically.

If you create the BlackBerry Configuration Database on a database server that you installed on a computer that is not the computer that hosts the BlackBerry Enterprise Server, you can install the BlackBerry database notification system manually after you complete the BlackBerry Enterprise Server installation process.

Before you begin:

- You must have the system administrator permission for the database.
- The database server must run on Windows Server® 2003.

1. On the database server, open the BlackBerry Enterprise Server installation files.
2. Perform one of the following actions:
   - If a 32-bit Microsoft® SQL Server® 2005 is running in your organization's environment, in the Tools\DBNS\x86 folder, copy the RimEsp.dll file to C:\Program Files\Microsoft SQL Server\MSSQL\Binn.
   - If a 64-bit Microsoft SQL Server 2005 is running in your organization's environment, in the Tools\DBNS\x64 folder, copy the RimEsp.dll file to C:\Program Files\Microsoft SQL Server\MSSQL\Binn.
3. Open the Microsoft SQL Server Management Studio.
4. Using the Microsoft SQL Server Management Studio, navigate to Database\DBInstallScripts\SQLServer\5.0 in the BlackBerry Enterprise Server installation files.

5. Open the **NotifyMasterInstall.sql** file.

6. Run the script.

7. Open the **NotifyInstall.sql** file.

8. Change `<_DATABASENAME_>` to the name of the BlackBerry Configuration Database (for example, BesMgmt).

9. Run the script.

10. Confirm that the Microsoft SQL Server Management Studio displays the "Function dbo.xp_RIMxxxx registered" message.

11. To add additional BlackBerry Configuration Database instances in your organization's environment, repeat steps 7 to 10.

### Best practice: Running the BlackBerry Enterprise Server

<table>
<thead>
<tr>
<th>Best practice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not change the startup type for the BlackBerry® Enterprise Server services.</td>
<td>When you install or upgrade the BlackBerry Enterprise Server, the setup application configures the startup type for the BlackBerry Enterprise Server services to automatic or manual. For example, the setup application configures the startup type for the BlackBerry Mail Store Service, BlackBerry Policy Service, and BlackBerry Synchronization Service to manual. To avoid errors in the BlackBerry Enterprise Server, do not change the startup type for the BlackBerry Enterprise Server services.</td>
</tr>
<tr>
<td>Do not change the account information for BlackBerry Enterprise Server services.</td>
<td>When you install or upgrade the BlackBerry Enterprise Server, the setup application configures the account information for the BlackBerry Enterprise Server services. Do not change the account information for the BlackBerry Enterprise Server unless the BlackBerry Enterprise Server documentation specifies that you can.</td>
</tr>
</tbody>
</table>
| Run the BlackBerry Configuration Panel as an administrator. | Consider the following guidelines if you are running the BlackBerry Configuration Panel on Windows Server® 2008:  
  - Log in to the computer with a user account that is in the Administrator group on the Windows Server.  
  - Right-click the BlackBerry Configuration Panel icon and click Run as administrator. |
Configuring support for Unicode languages

Configure support for Unicode languages

You can make sure that the messaging application can display the Unicode messages that the BlackBerry® device sends by configuring the BlackBerry® Enterprise Server to support Unicode languages (for example, Japanese, Korean, or Simplified Chinese).

1. On the computer that hosts the BlackBerry Enterprise Server, on the taskbar, click Start > Run.
2. Type regedit.
3. Click OK.
4. Perform one of the following actions:
   • If you are running a 32-bit version of Windows®, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion \BlackBerry Enterprise Server\Agents.
   • If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Research In Motion\BlackBerry Enterprise Server\Agents.
5. If the MAPIEncoding registry key exists, perform one of the following actions:
   • Delete the key.
   • Change the value of the key to 1.
6. Perform one of the following actions:
   • If you are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion \BlackBerry Enterprise Server\Setup.
   • If you are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Research In Motion\BlackBerry Enterprise Server\Setup.
7. Verify that the ConfigKeystoreCountry registry key is set to one of the following values, depending on your organization’s environment:
   • CN for Simplified Chinese
   • JP for Japanese
   • KR for Korean
8. In the Windows Services, restart the BlackBerry Dispatcher.
**Change the character encoding that the BlackBerry Enterprise Server uses to send Unicode messages**

By default, when the BlackBerry® Enterprise Server receives Unicode messages from BlackBerry devices, it uses UTF-8 character encoding to process the Unicode messages. If email applications cannot correctly display Unicode messages that devices send (for example, if email applications cannot display attachment file names or contact lists correctly), you can configure the BlackBerry Enterprise Server to select another character encoding to use to process Unicode messages.

**Before you begin:** Configure support for Unicode languages.

1. On the computer that hosts the BlackBerry Enterprise Server, on the taskbar, click **Start > Run**.
2. Type `regedit`.
3. Click **OK**.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows®, go to `HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion\BlackBerry Enterprise Server\Agents`.
   - If you are running a 64-bit version of Windows, go to `HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Research In Motion\BlackBerry Enterprise Server\Agents`.
5. Create a DWORD value that is named **AutoSelectOutgoingEncoding**.
6. Double-click the new DWORD value.
7. In the **Value data** field, perform one of the following actions:
   - To configure the BlackBerry Enterprise Server to send all email messages in UTF-8 and not select another character encoding, type **0**.
   - To configure the BlackBerry Enterprise Server to select the most appropriate character encoding when it encodes plain-text messages, type **1**. If the BlackBerry Enterprise Server cannot identify which character encoding to use, the BlackBerry Enterprise Server encodes plain-text messages in UTF-8.
   - To configure the BlackBerry Enterprise Server to select the most appropriate character encoding when it encodes email messages that use RTF or HTML, type **2**. If the BlackBerry Enterprise Server cannot identify which character encoding to use, the BlackBerry Enterprise Server encodes email messages that use RTF or HTML in UTF-8.
   - To configure the BlackBerry Enterprise Server to select the most appropriate character encoding when it encodes plain-text messages and email messages that use RTF or HTML, type **3**. If the BlackBerry Enterprise Server cannot identify which character encoding to use, the BlackBerry Enterprise Server encodes all email messages in UTF-8.
8. In the Windows Services, restart the BlackBerry Dispatcher.
Configure support for Unicode text in calendars on BlackBerry devices in a Microsoft Exchange environment

You must complete this task for all Microsoft® Exchange versions to ensure calendar items use the correct Unicode characters in fields such as subject, location, or notes.

Before you begin: In a Microsoft Exchange 2003 environment, install the hotfixes for wireless calendar synchronization for Microsoft Exchange 2003.

1. On the BlackBerry® Enterprise Server, on the Start menu, click Run.
2. Type regedit.
3. Click OK.
4. Perform one of the following actions:
   - If you are running a 32-bit version of Windows®, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion \BlackBerry Enterprise Server\Agents.
   - If you are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\Software\WOW6432Node \Research In Motion\BlackBerry Enterprise Server\Agents.
5. Create a DWORD value that is named SetLocaleIDs.
6. Set the value to 1.
7. In the Windows® Services, restart the BlackBerry Messaging Agent.

Configure the BlackBerry Administration Service instances in a pool to communicate across network subnets

The instances in the BlackBerry® Administration Service pool use multicast UDP to communicate with each other. If the BlackBerry Administration Service instances are located in different network subnets and your organization's network configuration does not permit multicast UDP across the network subnets, you must configure the BlackBerry Administration Service instances to use TCP to communicate with each other. For example, if your organization uses a UDP peer-to-peer firewall filter, you must configure the BlackBerry Administration Service instances to use TCP to communicate across the network subnets.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > BlackBerry Administration Service.
2. Click Edit component.
3. In the BlackBerry Administration Service pool drop-down list, click TCP with TCP PING.
4. Click Save all.
5. Stop all of the BlackBerry Administration Service instances, restart one BlackBerry Administration Service instance, and then restart the remaining BlackBerry Administration Service instances.
Log in to the BlackBerry Administration Service for the first time

To open the BlackBerry® Administration Service, you can use a browser on any computer that has access to the computer that hosts the BlackBerry Administration Service.

Before you begin: To manage a BlackBerry device using the BlackBerry Administration Service while the BlackBerry device is connected to the computer, the browser must permit Microsoft® ActiveX® controls.

1. In the browser, type https://<server_name>/webconsole/app, where <server_name> is the name of the computer that hosts the BlackBerry Administration Service.
2. In the User name field, type admin.
3. In the Password field, type the password that you created during the installation process.
4. In the Log in using drop-down list, click BlackBerry Administration Service.
5. Click Log in.

There is a problem with this website's security certificate

Description
The browser displays this error message when you try to navigate to the BlackBerry® Administration Service or BlackBerry Monitoring Service using Windows® Internet Explorer® version 7 or later.

Possible solution
Add the web address for the BlackBerry Administration Service or BlackBerry Monitoring Service to the list of trusted web sites in Windows Internet Explorer, and install the certificate for the BlackBerry Administration Service or BlackBerry Monitoring Service in the certificate store of your computer.

1. In Windows Internet Explorer, navigate to the BlackBerry Administration Service console or BlackBerry Monitoring Service console.
2. Click Continue to this website (not recommended).
3. On the Tools menu, click Internet Options.
5. Click Sites.
6. Click Add to add the console to the list of trusted web sites.
7. Click Close.
8. Click OK.
9. In the browser window, on the toolbar, click Certificate Error.
10. Click View certificates.
12. Complete the instructions in the Certificate Import Wizard. If you are trying to log in to the BlackBerry Administration Service or BlackBerry Monitoring Service using a computer that runs Windows Vista™, perform the following actions in the Certificate Import Wizard.
   a. In the Certificate Store dialog box, click **Place all certificates in the following store**.
   b. Click **Browse**.
   c. Click **Trusted Root Certification Authorities**.
   d. Click **OK**.
13. Close and reopen the browser.

**Configuring a computer for monitoring**

**Configure the SNMP service for monitoring**

You can configure the SNMP service on the computer that hosts the BlackBerry® Enterprise Server so that the BlackBerry Monitoring Service can monitor BlackBerry Enterprise Server activity.

**Before you begin:** Verify that the SNMP service is installed and running.

1. On a computer that hosts the BlackBerry Enterprise Server or BlackBerry Enterprise Server components, in the Windows® Services, right-click **SNMP Service**. Click **Properties**.
2. On the **General** tab, change the startup type to **Automatic**.
3. On the **Traps** tab, in the **Community name** field, type the community name for the SNMP service. The field is case-sensitive.
4. In the **Trap Destinations** section, add the IP address of the computer that hosts the BlackBerry Monitoring Service.
5. On the **Security** tab, in the **Accepted community names** section, add the community name that you typed in step 3. The SNMP community name is read-only.
6. Select the **Accept SNMP packets from any host** or **Accept SNMP packets from these hosts** option, depending on your organization's environment.
7. If you selected **Accept SNMP packets from these hosts**, type the IP address of the computer that hosts the BlackBerry Monitoring Service.
8. Click **Apply**.
9. In the **Services** list, right-click **SNMP Service**. Click **Restart**.

**Configure the BlackBerry Monitoring Service to monitor a BlackBerry Enterprise Server**

**Before you begin:** Verify that the computer that hosts the BlackBerry® Enterprise Server has access to the computer that hosts the BlackBerry Monitoring Service.
1. In a browser, type `https://<server_name>:8443/webconsole/app`, where `<server_name>` is the FQDN of the computer that hosts the BlackBerry Monitoring Service.

2. Log in as an administrator that has permission to access the BlackBerry Monitoring Service.

3. On the **Configuration** menu, expand **Servers**.

4. Click **Manage servers**.

5. Click the **Edit** icon for the BlackBerry Enterprise Server that you want the BlackBerry Monitoring Service to monitor.

6. In the **SNMP configuration** section, type the SNMP port number that the SNMP service that is located on the computer that hosts the BlackBerry Enterprise Server uses.

7. In the **SNMP configuration** section, type the SNMP community name that the SNMP service that is located on the computer that hosts the BlackBerry Enterprise Server uses. The SNMP community name is case sensitive.

8. In the **SNMP configuration** section, select the **Turn on monitoring** check box.

9. Click **Save**.

**Configuring communication with distributed components**

**Connecting to a BlackBerry Attachment Service**

Perform the following actions if you installed the BlackBerry® Attachment Service on a computer that is separate from the computer that host the BlackBerry® Enterprise Server or BlackBerry Enterprise Server components that connect to the BlackBerry Attachment Service. These actions ensure that BlackBerry Enterprise Server components can connect to the BlackBerry Attachment Service.

**Connect a BlackBerry MDS Connection Service to a remote BlackBerry Attachment Service**

Perform the following task if you did not install the BlackBerry® Attachment Service on the same computer as the BlackBerry MDS Connection Service.

1. In the BlackBerry Administration Service, on the **Servers and components** menu, expand **BlackBerry Solution topology > BlackBerry Domain > Component view > Attachment > Connector**.

2. Click the BlackBerry Attachment Connector that is installed with the BlackBerry MDS Connection Service.

3. Click **Edit instance**.

4. On the **Supported Attachment Server instances** tab, in the **Name** drop-down list, select the BlackBerry Attachment Service instance that you want to connect the BlackBerry MDS Connection Service to.

5. In the **Results query period(s)** field, type the number of seconds that you want the BlackBerry MDS Connection Service to wait for a response before it sends a request to another BlackBerry Attachment Service instance.

6. In the **Dedicated server** drop-down list, click **yes** if you want the BlackBerry Attachment Service instance to process specific content types only for the BlackBerry MDS Connection Service.
7. In the Pool drop-down list, perform one of the following actions:
   • To include the BlackBerry Attachment Service instance in the primary group of instances in a pool, select **Primary**. You must include at least one BlackBerry Attachment Service instance in the primary group. If you are not configuring high availability, select **Primary**.
   • To include the BlackBerry Attachment Service instance in the secondary group, select **Secondary**.
8. Perform the following actions:
   • To turn on support for an attachment file format, in the Extensions section, type the file extension of the format. Click the **Add** icon beside the extension that you typed.
   • To turn off support for an attachment file format, in the Extensions section, click the **Delete** icon beside the file extension.
9. Click the **Add** icon.
10. Click **Save All**.
11. Repeat steps 2 to 10 for each BlackBerry MDS Connection Service instance in your organization's environment that requires the BlackBerry Attachment Service instance.

Connect the BlackBerry Collaboration Service to a remote BlackBerry Attachment Service

Using the BlackBerry® Client for IBM® Lotus® Sametime®, users can send files to contacts in their contact lists. To optimize files for viewing on BlackBerry devices, the BlackBerry Collaboration Service must connect to a BlackBerry Attachment Service instance. If you did not install the BlackBerry Attachment Service instance on the same computer as the BlackBerry Collaboration Service, you must connect the BlackBerry Collaboration Service to a remote BlackBerry Attachment Service.

1. On the computer that hosts the BlackBerry Collaboration Service, navigate to C:\Program Files\Research In Motion \BlackBerry Enterprise Server\BBIM\Servers\<server_name>\config.
2. In a text editor, open the **rimpublic.property** file.
3. At the end of the file, type the following text on separate lines:

   **Attachment.Server.host=<attachment_server_host_name>**

   **Attachment.Server.port.asp=1900**

   **Attachment.Server.port.rqp=2000**

4. To connect another BlackBerry Collaboration Service to the BlackBerry Attachment Service instance, type the text that appears in step 3 for this BlackBerry Collaboration Service instance.
5. Save and close the file.
6. In the Windows® Services, restart the BlackBerry Collaboration Service.
7. On the computer that hosts the BlackBerry Attachment Service, in the Registry Editor, navigate to HKEY_LOCAL_MACHINE \SOFTWARE\Research In Motion\BBAttachServer\BBAttachBESExtension.
8. On the computer that hosts the BlackBerry Attachment Service, in the Registry Editor, perform one of the following actions:
   • If you are running a 32-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion \BBAttachServer\BBAttachBESExtension.
If you are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\Software\WOW6432Node\Research In Motion\BBAAttachServer\BBAAttachBESExtension.


10. In the Windows Services, restart the BlackBerry Attachment Service.

**Connect a BlackBerry Enterprise Server to a remote BlackBerry Attachment Service**

Perform the following actions if you did not install the BlackBerry® Attachment Service on the same computer as the BlackBerry® Enterprise Server. The BlackBerry Messaging Agent requires access to the remote BlackBerry Attachment Service so that it can process attachment requests.

1. In the BlackBerry Administration Service, on the **Servers and components** menu, expand **BlackBerry Solution topology** > **BlackBerry Domain** > **Component view** > **Attachment** > **Connector**.

2. Click the BlackBerry Attachment Connector that is installed with the BlackBerry Enterprise Server.

3. Click **Edit instance**.

4. On the **Supported Attachment Server instances** tab, in the **Name** drop-down list, select the BlackBerry Attachment Service instance that you want to connect to the BlackBerry Enterprise Server.

5. In the **Results query period(s)** field, type the number of seconds that you want the BlackBerry Enterprise Server to wait for a response before it sends a request to another BlackBerry Attachment Service instance.

6. In the **Dedicated server** drop-down list, click **yes** if you want the BlackBerry Attachment Service instance to process specific content types only for the BlackBerry Enterprise Server.

7. In the **Pool** drop-down list, perform one of the following actions:
   - To include the BlackBerry Attachment Service instance in the primary group of instances in a pool, select **Primary**. You must include at least one BlackBerry Attachment Service instance in the primary group. If you are not configuring BlackBerry Attachment Service high availability, select **Primary**.
   - To include the BlackBerry Attachment Service instance in the secondary group, select **Secondary**.

8. Perform the following actions:
   - To turn on support for an attachment file format, in the **Extensions** section, type the file extension of the format. Click the **Add** icon beside the extension that you typed.
   - To turn off support for an attachment file format, in the **Extensions** section, click the **Delete** icon beside the file extension.

9. Click the **Add** icon.

10. Click **Save All**.

11. Repeat steps 2 to 10 for each BlackBerry Enterprise Server instance in your organization's environment that requires the BlackBerry Attachment Service instance.

12. Restart the BlackBerry Enterprise Server.
   a. In the **Component view**, expand **BlackBerry Enterprise Server**.
   b. Click the BlackBerry Enterprise Server instance.
   c. Click **Restart instance**.
Connect a remote BlackBerry Attachment Service to a BlackBerry Enterprise Server
Perform the following actions if you did not install the BlackBerry® Attachment Service on the same computer as the BlackBerry® Enterprise Server. The BlackBerry Messaging Agent requires access to the remote BlackBerry Attachment Service so that it can process attachment requests.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > Attachment > Server.
2. Click the name of the remote BlackBerry Attachment Service.
3. Click Edit instance.
4. On the Supported Attachment Connector instances tab, add the BlackBerry Attachment Connector that is installed with the BlackBerry Enterprise Server.
5. Click Save All.
6. To restart the BlackBerry Attachment Service, on the Instance information tab, in the Status list, click Restart instance.

Connecting to a BlackBerry Router
Perform the following tasks if you installed the BlackBerry® Router on a computer that is separate from the computer that hosts the BlackBerry® Enterprise Server. These tasks ensure that the BlackBerry Enterprise Server can connect to the BlackBerry Router.

Permit a BlackBerry Enterprise Server to connect to a remote BlackBerry Router
If you installed a BlackBerry® Router on a computer that is separate from the computer that hosts a BlackBerry® Enterprise Server, you must permit the BlackBerry Dispatcher that you installed with the BlackBerry Enterprise Server to connect to the BlackBerry Router. The BlackBerry Router that you installed on a separate computer can send BlackBerry traffic from the BlackBerry Enterprise Server to BlackBerry devices.

1. On the computer that hosts the BlackBerry Router, click Start > Run.
2. Type regedit.
3. Click OK.
4. Perform one of the following actions:
   • If you are running a 32-bit version of Windows®, change the registry entry value for \HKEY_LOCAL_MACHINE \SOFTWARE\Research In Motion\BlackBerryRouter\AllowRemoteServices from 0 to 1.
   • If you are running a 64-bit version of Windows, change the registry entry value for \HKEY_LOCAL_MACHINE \SOFTWARE\WOW6432Node \Research In Motion\BlackBerryRouter\AllowRemoteServices from 0 to 1.
5. In the Windows Services, restart the BlackBerry Router service.

Connect a BlackBerry Enterprise Server to a remote BlackBerry Router
1. In the BlackBerry® Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > BlackBerry Enterprise Server.
2. Click the BlackBerry® Enterprise Server instance or BlackBerry Enterprise Server pair that you want to assign the BlackBerry Router to.
3. Click **Edit instance**.
4. In the **Router address** section, type the FQDN of the computer that hosts the BlackBerry Router.
5. If the BlackBerry Router uses a port number other than port number 3101, in the **Port override** field, type the port number.
6. Click the **Add** icon.
7. Click **Save All**.
8. Restart the BlackBerry Enterprise Server using one of the following methods:
   - If you changed a BlackBerry Enterprise Server instance, on the **Instance** tab, click **Restart instance**.
   - If you changed a BlackBerry Enterprise Server pair, click one of the instances and on the **Instance** tab, click **Restart instance**. Repeat this step for the other instance.
   - In the Windows® Services, restart the BlackBerry Dispatcher.

**Configure multiple BlackBerry Enterprise Server instances to use the same BlackBerry MDS Integration Service**

If you installed a BlackBerry® MDS Integration Service instance on a computer that is separate from a computer that hosts a BlackBerry® Enterprise Server, you must connect the BlackBerry MDS Integration Service instance to a BlackBerry Enterprise Server so that you can use the BlackBerry MDS Integration Service to send BlackBerry® MDS Runtime Applications and updates to BlackBerry devices.

You can also connect the BlackBerry MDS Integration Service to multiple BlackBerry Enterprise Server instances if you want to make the BlackBerry MDS Runtime Applications that are stored in the BlackBerry MDS Application Repository available to users that are associated with multiple BlackBerry Enterprise Server instances.

1. In the BlackBerry Administration Service, on the **Servers and components** menu, expand **BlackBerry Solution topology > BlackBerry Domain > Component view > MDS Integration Service**.
2. Click the instance that you want to change.
3. Click **Edit instance**.
4. On the **Supported Dispatcher instances** tab, in the **Available Dispatcher instances** list, click the BlackBerry Enterprise Server instance that you want to configure to use the BlackBerry MDS Integration Service.
5. Click **Add**.
6. Repeat steps 4 and 5 for each BlackBerry Enterprise Server instance that you want to configure to use the BlackBerry MDS Integration Service.
7. Click **Save all**.
Restrict database permissions for the BlackBerry Attachment Service

The BlackBerry® Attachment Service accesses the BlackBerry Configuration Database to read attachment data using a Windows® account or a SQL authentication account. To limit the access that the BlackBerry Attachment Service account has to the tables in the BlackBerry Configuration Database, you can configure a BlackBerry Attachment Service account that has limited database permissions. This account is not the same as the account that the BlackBerry® Enterprise Server uses to access the BlackBerry Configuration Database.

Before you begin:
- Create a Windows® account for the BlackBerry Attachment Service.
- To use database authentication, create a SQL authentication account for the BlackBerry Attachment Service.

1. In the Microsoft® SQL Server® management console, create a SQL login for the Windows account or SQL authentication account.
2. Assign the account to the rim_db_AttachmentServer role in the BlackBerry Configuration Database.
3. If you want the BlackBerry Attachment Service to use a SQL authentication account to access the BlackBerry Configuration Database, perform the following actions:
   a. On the computer that you installed the BlackBerry Attachment Service on, log in using the Windows account that the BlackBerry Attachment Service is running on.
   b. Click Start > Run.
   c. Type regedit. Click OK.
   d. If you are running a 32-bit version of Windows, navigate to HKEY_CURRENT_USER\SOFTWARE\Research In Motion.
   e. If you are running a 64-bit version of Windows, navigate to HKEY_CURRENT_USER\SOFTWARE\WOW6432Node \Research In Motion.
   f. Create the BBAttachServer\Database keys.
   g. In the Database key, create the Login and Password string values for the SQL authentication account.

After you finish: After you complete the BlackBerry Attachment Service installation process, in the Windows Services, verify that the service for the BlackBerry Attachment Service is using the Windows account that you configured. If you need to change the account information, restart the BlackBerry Attachment Service.
Configuring minimum Microsoft SQL Server permissions for the Windows account

The BlackBerry® Enterprise Server setup application requires the Windows® account that it uses during the installation process or upgrade process to have Microsoft® SQL Server® permissions to create or upgrade the BlackBerry Configuration Database. The setup application requires the Windows account to have more Microsoft SQL Server permissions to install the BlackBerry Enterprise Server than the BlackBerry Enterprise Server requires to run.

After the installation or upgrade process completes, you can change the Microsoft SQL Server permissions of the Windows account to the Microsoft SQL Server permissions that the BlackBerry Enterprise Server requires to run. When you change the Microsoft SQL Server permissions of the Windows account, you can use Microsoft SQL Server security to minimize the operations that the Windows account can perform on the BlackBerry Configuration Database.

The following table describes the Microsoft SQL Server permissions for the setup application and the Windows account that the BlackBerry Enterprise Server uses to run.

<table>
<thead>
<tr>
<th>Server and database roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>db_owner</td>
<td>The setup application requires this role to install and upgrade the BlackBerry Configuration Database, BlackBerry MDS Integration Service database, and BlackBerry Monitoring Service database. You can remove this role from the Windows account that the BlackBerry Enterprise Server uses to run after the setup application creates or upgrades the BlackBerry Configuration Database.</td>
</tr>
<tr>
<td>rim_db_bes_server</td>
<td>The BlackBerry Enterprise Server requires this role to run the BlackBerry Enterprise Server services. The setup application or the createDB executable creates the role automatically when it creates the BlackBerry Configuration Database. This role is the minimum Microsoft SQL Server permission for running the BlackBerry Enterprise Server.</td>
</tr>
</tbody>
</table>

Configure minimum Microsoft SQL Server permissions for the Windows account

You can configure the minimum Microsoft® SQL Server® permissions for the Windows® account that the BlackBerry® Enterprise Server uses to run.

1. Open the Microsoft SQL Server console.
2. Expand **Microsoft SQL Server > Security > Logins.**
3. Right-click the Windows account that the BlackBerry Enterprise Server uses to run. Click Properties.
4. Map the Windows account to the BlackBerry Configuration Database.
5. Change the **Database role membership** to `rim_db_bes_server`.
6. Remove all other database role memberships.
7. Apply your changes.

**Changing the BlackBerry Configuration Database**

If you want a BlackBerry® Enterprise Server to use a different BlackBerry Configuration Database, you must run the setup application and specify the BlackBerry Configuration Database that you want the BlackBerry Enterprise Server to use.

When you change the BlackBerry Configuration Database, the BlackBerry Enterprise Server becomes unavailable and users cannot send or receive messages on their BlackBerry devices. Organizer data synchronization occurs after you have changed the BlackBerry Configuration Database.
Adding or removing BlackBerry Enterprise Server components

If you installed a BlackBerry® Enterprise Server previously, you can add one or more BlackBerry Enterprise Server components to the existing BlackBerry Enterprise Server, or you can remove existing BlackBerry Enterprise Server components from the BlackBerry Enterprise Server.

To add or remove a BlackBerry Enterprise Server component, you must run the setup application again. The setup application removes the existing BlackBerry Enterprise Server software from the computer, and installs only the BlackBerry Enterprise Server components that you select. You can also choose to install either a BlackBerry Enterprise Server or install one or more remote components.

If you installed a BlackBerry Enterprise Server and, when you run the setup application again you select the remote component setup option, the setup application removes the existing BlackBerry Enterprise Server software. If you installed one or more remote components and you select the BlackBerry Enterprise Server setup option, the setup application removes the existing remote components.

You can add or remove the following BlackBerry Enterprise Server components.

<table>
<thead>
<tr>
<th>Component</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>BlackBerry Enterprise Server</td>
<td>You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• You can remove a BlackBerry Enterprise Server (which includes a BlackBerry Attachment Service, BlackBerry Dispatcher, BlackBerry MDS Connection Service, BlackBerry Messaging Agent, BlackBerry Policy Service, BlackBerry Router, and BlackBerry Synchronization Service) and install one or more remote components instead.</td>
</tr>
<tr>
<td></td>
<td>• You can remove any remote components and install a BlackBerry Enterprise Server instead.</td>
</tr>
<tr>
<td>BlackBerry Administration Service</td>
<td>You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Administration Service with a BlackBerry Enterprise Server, you can remove the BlackBerry Administration Service.</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Enterprise Server, you can add a BlackBerry Administration Service.</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Administration Service as a remote component, you can remove it.</td>
</tr>
<tr>
<td>Component</td>
<td>Options</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BlackBerry Attachment Service</td>
<td>You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Attachment Service as a remote component, you can remove it.</td>
</tr>
<tr>
<td></td>
<td>• You can add a BlackBerry Attachment Service to an existing installation of another remote component.</td>
</tr>
<tr>
<td>BlackBerry Collaboration Service</td>
<td>You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Collaboration Service with a BlackBerry Enterprise Server, you can remove the BlackBerry Collaboration Service.</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Enterprise Server, you can add a BlackBerry Collaboration Service.</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Collaboration Service as a remote component, you can remove it.</td>
</tr>
<tr>
<td></td>
<td>• If you installed remote components, you can add a BlackBerry Collaboration Service.</td>
</tr>
<tr>
<td>BlackBerry MDS Connection Service</td>
<td>You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry MDS Connection Service as a remote component, you can remove it.</td>
</tr>
<tr>
<td></td>
<td>• You can add a BlackBerry MDS Connection Service to an existing installation of another remote component.</td>
</tr>
<tr>
<td>BlackBerry MDS Integration Service</td>
<td>You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry MDS Integration Service with a BlackBerry Enterprise Server, you can remove the BlackBerry MDS Integration Service.</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry Enterprise Server, you can add a BlackBerry MDS Integration Service.</td>
</tr>
<tr>
<td></td>
<td>• If you installed a BlackBerry MDS Integration Service as a remote component, you can remove it.</td>
</tr>
<tr>
<td></td>
<td>• If you installed remote components, you can add a BlackBerry MDS Integration Service.</td>
</tr>
<tr>
<td>BlackBerry Monitoring Service</td>
<td>You can choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Component | Options
--- | ---
BlackBerry Monitoring Service | • If you installed a BlackBerry Monitoring Service as a remote component, you can remove it.
• You can add a BlackBerry Monitoring Service to an existing installation of another remote component.

Only one BlackBerry Monitoring Service instance can exist in your organization's BlackBerry Domain.

BlackBerry Router | You can choose one of the following options:
• If you installed a BlackBerry Router as a remote component, you can remove it.
• You can add a BlackBerry Router to an existing installation of another remote component.

Add or remove a BlackBerry Enterprise Server component

When you perform this task, the BlackBerry® Enterprise Server components on the computer that you perform this task on are unavailable for use until the installation process is complete and you have restarted the BlackBerry Enterprise Server services. The process includes a restart of a BlackBerry Enterprise Server.

Before you begin:
• If you configured high availability and you want to add or remove a BlackBerry Enterprise Server component from a computer that hosts a primary BlackBerry Enterprise Server, perform a manual failover to the standby BlackBerry Enterprise Server so that users are not affected by the adding or removing of a BlackBerry Enterprise Server component.
• If you want to remove a BlackBerry Router, BlackBerry Attachment Service, BlackBerry MDS Connection Service, BlackBerry Collaboration Service, or BlackBerry MDS Integration Service, use the BlackBerry Administration Service to remove the component from the list of component instances that the BlackBerry Enterprise Server instances use.

1. Log in to a computer using the Windows® account that you used to install the BlackBerry Enterprise Server components.
2. Stop the BlackBerry Enterprise Server services.
3. In the BlackBerry Enterprise Server installation files, double-click `setup.exe`. If your operating system is Windows Server® 2008, run `setup.exe` as an administrator.
4. In the Setup type dialog box, select Use an existing BlackBerry Configuration Database.
5. In the Database information dialog box, perform the following actions:
   • Verify the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise Server instances use.
   • If you configured the database server to use static ports, select the Static option. If the static port number is not 1433, in the Port field, type the port number.
6. If you want to configure database mirroring, in the **Database mirroring options** dialog box, you can select **Add support for database mirroring** and type the name of the database server that hosts the mirror database in the **Name of the mirror database server** field. The setup application does not create the BlackBerry Configuration Database on the mirror Microsoft® SQL Server®; it adds a registry key to the computer that includes the name of the mirror Microsoft SQL Server.

7. In the **Setup options** dialog box, select the components that you want to add and clear the checkboxes for the components that you want to remove. The setup application upgrades any components that you installed previously that you select and the components might be unavailable for users during the installation process.

8. In the **Microsoft Exchange Server** dialog box, click **OK**.

9. When the setup application prompts you to restart the computer, click **Yes**.

10. Log in to the computer using the same account that you used in step 1.

11. In the **Application extensibility information** dialog box, consider the following information:
   - You can type an FQDN to create a BlackBerry MDS Integration Service pool or add the BlackBerry MDS Integration Service instance to a pool that you created during a previous installation process.
   - To configure a hardware load-balancer for the BlackBerry MDS Integration Service pool, you can type an FQDN that corresponds to a DNS record in the DNS server that maps the FQDN to the IP address of the virtual server that you configured on the hardware load-balancer.
   - The setup application creates the BlackBerry MDS Integration Service database on the database server that hosts the BlackBerry Configuration Database.
   - If you add the BlackBerry MDS Integration Service instance to an existing pool, the setup application selects the existing BlackBerry MDS Integration Service database and existing administrator account and publisher account.

12. In the **Administration settings** dialog box, consider the following information:
   - In the **Pool name** field, type a valid FQDN or IP address. The setup application uses the FQDN or IP address to create the BlackBerry Administration Service web address.
   - You must type the password for the SSL certificate that the BlackBerry Administration Service uses for authentication with browsers.

13. In the **Microsoft® Active Directory® settings** dialog box, in the **User password** field, type the password for the Microsoft Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server instance uses to authenticate to Microsoft Active Directory. If you want to specify a different user name and user domain, you must make sure that the user domain belongs to the Microsoft Active Directory forest that the Microsoft Exchange organization belongs to. After you click the **Next** button, if the setup application cannot locate any of the global catalog servers that are associated with the Microsoft Active Directory account, you must choose the global catalog servers that you want to add to the list manually. To add a global catalog server to the list, click the **Add** button and select the appropriate server. Each global catalog server that you add to the list must belong to the domain that the Microsoft Active Directory user account belongs to.

14. Start the services for the BlackBerry Enterprise Server instance.

15. In the **Console addresses** dialog box, copy the web addresses for the BlackBerry Enterprise Server components and paste them into a document for future reference. You can use the web addresses to log in to the BlackBerry Enterprise Server components.
After you finish:
- If you added a component, to view the component information in the BlackBerry Administration Service, perform one of the following actions:
  - Restart the BlackBerry Administration Service.
  - On every computer that hosts the BlackBerry Administration Service, in the BlackBerry Administration Service, in the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain. Click Component view and then click Refresh list of registered components.
- If you removed a component other than the BlackBerry Router, to delete the component information from the BlackBerry Configuration Database, use the BlackBerry Administration Service.
- If you reinstalled the BlackBerry Administration Service, in Windows® Internet Explorer®, delete the cache content.

Remove BlackBerry Enterprise Server component information from the BlackBerry Configuration Database

If you remove the software for a BlackBerry® Enterprise Server component from a computer, the software removal process does not delete the component information from the BlackBerry Configuration Database. You must delete the information manually using the BlackBerry Administration Service so that the BlackBerry Administration Service does not display the information for the component that you removed.

Before you begin: Remove the software for the BlackBerry Enterprise Server component from the computer.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain.
2. Click Component view.
3. Beside the component that you removed, which appears as Uninstalled, click the Delete icon.
4. Click Yes - Delete the instance and wait until you return to the main page.
Removing the BlackBerry Enterprise Server software

Remove the BlackBerry Enterprise Server software

1. On the taskbar, click **Start > Settings > Control Panel > Add/Remove Programs**.
2. Click **Blackberry Enterprise Server**.
3. Click **Remove**.
4. Click **Yes**.

**After you finish:** To remove third-party software that the setup application installed during the BlackBerry® Enterprise Server installation process, you can remove the JRE™ software and Java® Web Start software from the computer.

Delete registry keys

The BlackBerry® Enterprise Server setup application might not remove all of the registry keys from the Windows® registry when you remove the BlackBerry Enterprise Server software. You can remove the registry keys from the Windows registry manually after the process to remove the BlackBerry Enterprise Server software completes successfully.

1. On the computer that you removed the BlackBerry Enterprise Server software from, on the **Start** menu, click **Run**.
2. Type **regedit**.
3. Click **OK**.
4. Delete the remaining registry keys.

BlackBerry Enterprise Server registry keys

The setup application might not remove the following BlackBerry® Enterprise Server registry keys from the Windows® Registry when you remove the BlackBerry Enterprise Server software.

<table>
<thead>
<tr>
<th>Key</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Research In Motion</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE</td>
</tr>
<tr>
<td>BBAttachServer and any keys that start with BAS, BB, or BlackBerry</td>
<td>HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services</td>
</tr>
<tr>
<td>BBAttachServer and any keys that start with BAS, BB, or BlackBerry</td>
<td>HKEY_LOCAL_MACHINE\System\ControlSet001\Services</td>
</tr>
<tr>
<td>BBAttachServer and any keys that start with BAS, BB, or BlackBerry</td>
<td>HKEY_LOCAL_MACHINE\System\ControlSet00n\Services</td>
</tr>
</tbody>
</table>
Removing the BlackBerry database notification system

You must remove the BlackBerry® database notification system manually if you installed it manually. You can remove the BlackBerry database notification system from one BlackBerry Configuration Database instance or all BlackBerry Configuration Database instances.

Remove the BlackBerry database notification system from a BlackBerry Configuration Database

1. Open the Microsoft® SQL Server® Management Studio.
2. Using the console, navigate to Database\DBInstallScripts\SQLServer\5.0 in the BlackBerry® Enterprise Server installation files.
3. Open the NotifyUnInstall.sql file.
4. Delete all commands after "delete notification stored procedures" and "delete notification tables."
5. Run the script.
6. Perform one of the following actions:
   - Restart Microsoft® SQL Server®.
   - In Windows® Explorer, navigate to C:\Program Files\Microsoft SQL Server\MSSQL\Binn. Rename the RimEsp.dll file (for example, RimEspXXX.tmp).

Remove the BlackBerry database notification system from all BlackBerry Configuration Database instances

1. Open the Microsoft® SQL Server® Management Studio.
2. Using the console, navigate to Database\DBInstallScripts\SQLServer\5.0 in the BlackBerry® Enterprise Server installation files.

---

<table>
<thead>
<tr>
<th>Key</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Research In Motion</td>
<td>HKEY_CURRENT_USER\Software</td>
</tr>
<tr>
<td>Any keys that are named BlackBerryServer, or are named the name of the BlackBerry Enterprise Server in your organization</td>
<td>HKEY_CURRENT_USER\Software\Microsoft\Windows NT \CurrentVersion\Windows Messaging SubSystem\Profiles</td>
</tr>
<tr>
<td>Research In Motion</td>
<td>HKEY_USERS\DEFAULT\Software</td>
</tr>
<tr>
<td>BESManmmcc.dll</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows \CurrentVersion\App Paths</td>
</tr>
<tr>
<td>Any key where ProductName is BlackBerry Enterprise Server</td>
<td>HKEY_CLASSES_ROOT\Installer\Products</td>
</tr>
</tbody>
</table>
3. Open the **NotifyUnInstall.sql** file.
4. Run the script.
5. Using Windows® Explorer, navigate to `<drive>\Program Files\Microsoft SQL Server\MSSQL\Binn.`
6. Delete the **RimEsp.dll** file.
Troubleshooting the BlackBerry Enterprise Server installation process

Failed to write License Key to the Database

This error message appears when you try to add the BlackBerry® Client Access License key during the installation process.

**Possible solution**

After you restart the computer during the BlackBerry® Enterprise Server installation process, you must log in using the same Windows® account that you used to start the installation process.

1. Close the setup application.
2. Log out of the computer.
3. Log in to the computer.
4. Restart the setup application.

Previous version detected but no database available

This error message appears when you cannot start the setup application or the setup application stops responding.

**Possible solution**

Verify that the registry keys that identify the BlackBerry® Configuration Database exist in the Windows® registry.

1. On the computer that you want to install or upgrade the BlackBerry® Enterprise Server on, on the Start menu, click Run.
2. Type regedit.
3. Click OK.
4. In the left pane, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server \Database.
5. If necessary, create case-sensitive strings that you name DatabaseName and DatabaseServerMachineName.
6. Specify the name of the BlackBerry Configuration Database as the value for DatabaseName.
7. Specify the FQDN name of the database server as the value for DatabaseServerMachineName.
8. Restart the setup application.
A third-party tool did not install and the BlackBerry Enterprise Server setup application closed

**Possible solution**

1. On the BlackBerry® Enterprise Server installation media, open the **Tools** folder.
2. Double-click the setup application file for the tool that you want to install.
3. Complete the instructions on the screen.
4. Restart the BlackBerry Enterprise Server setup application.

The setup application did not prompt you to change or confirm the MAPI profile

**Possible solution**

Create and change the MAPI profile manually.

1. On the BlackBerry® Enterprise Server installation media, open the **Tools** folder.
2. Double-click the **Fixmapiscvc.exe** file.
3. Verify that **mapiscvc.inf** is installed in C:\winnt\system32\ or C:\windows\system32\.
4. On the taskbar, click **Start > All Programs > BlackBerry Enterprise Server > BlackBerry Server Configuration**.
5. On the **BlackBerry Server** tab, click **Edit MAPI profile**.
6. Type the Microsoft® Exchange server name.
7. Click the Windows® account that is associated with the MAPI profile.
8. Click **OK**.

The BlackBerry Monitoring Service cannot monitor events

**Possible cause**

The SNMP service was not installed before the BlackBerry® Enterprise Server software was installed.

**Possible solution**

To permit the BlackBerry Monitoring Service to monitor a BlackBerry Enterprise Server activity, you can install the SNMP service on the computer after you install a BlackBerry Enterprise Server.

1. Verify that the computer has access to the Windows® installation media.
2. On the computer that hosts the BlackBerry Enterprise Server or BlackBerry Enterprise Server components, on the taskbar, click Start > Settings > Control Panel > Add/Remove Programs > Add/Remove Windows Components.
5. Click OK.
6. When the installation wizard prompts you, install the files from the Windows installation media.
7. Complete the installation wizard.

To complete the installation process, configure the SNMP service to monitor the BlackBerry Enterprise Server activity.

You cannot determine the BlackBerry Attachment Connector that the BlackBerry Enterprise Server or the BlackBerry MDS Connection Service uses

If you install a BlackBerry® Enterprise Server, the setup application also installs two BlackBerry Attachment Connector instances automatically. One of the BlackBerry Attachment Connector instances connects the BlackBerry Enterprise Server to the BlackBerry Attachment Service. The other instance connects the BlackBerry MDS Connection Service to the BlackBerry Attachment Service. During the installation process, the setup application gives both BlackBerry Attachment Connector instances a name that includes the computer name (for example, <computer_name>_AC).

The BlackBerry Administration Service displays the names of both the BlackBerry Attachment Connector instances. By default, you cannot determine easily which instance connects to the BlackBerry Enterprise Server or the BlackBerry MDS Connection Service, so you can change the display names of both the BlackBerry Attachment Connector instances to make them easier to identify.

1. In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain > Component view > Attachment > Connector.
2. Click one of the BlackBerry Attachment Connector instances.
3. On the Instance information tab, locate either the MDS Connection Service Instance name section or the Email (Exchange) Instance name section. Consider the following naming conventions:
   • If you locate the section that is named MDS Connection Service Instance name, the BlackBerry MDS Connection Service connects to this BlackBerry Attachment Connector instance.
   • If you locate the section that is named Email (Exchange) Instance name, the BlackBerry Enterprise Server connects to this BlackBerry Attachment Connector instance.
4. Click Edit instance.
5. Perform one of the following actions:
   • If the BlackBerry MDS Connection Service connects to the BlackBerry Attachment Connector instance, in the Instance information section, in the Friendly description field, type a unique name (for example, <server_name>_AC_MDSCS).
   • If the BlackBerry Enterprise Server uses the BlackBerry Attachment Connector instance, in the Instance information section, in the Friendly description field, type a unique name (for example, <server_name>_AC_BES).
6. Click **Save all**.

The BlackBerry Administration Service updates the list of BlackBerry Attachment Connector instances automatically to use the names that you typed.

**Users experience unexpected behavior with message lists and calendars on BlackBerry devices**

**Possible cause**

If the MAPI and CDO client version 6.5.8022 was installed without uninstalling previous versions of the MAPI and CDO client (including the associated .DLL files), users might experience unexpected behavior with message lists and calendars on BlackBerry® devices.

**Possible solution**

For more information about Microsoft® Exchange Server MAPI Client and CDO version 1.2.1, visit [www.microsoft.com](http://www.microsoft.com).

1. In the Windows® Services, stop the services for the BlackBerry® Enterprise Server and any processes that use the MAPI and CDO client.
2. Remove the MAPI and CDO client version 6.5.8022.
3. Verify that the following files are not present in C:\Windows\System32 or any other directory in the environment path:
   - CDO.DLL
   - EMSABP32.DLL
   - EMSMDB32.DLL
   - EMSUI32.DLL
   - EMSUIX32.DLL
   - GAPI32.DLL
   - MAPISP32.EXE
   - MSPST32.DLL
   - WMSUI32.DLL
4. In C:\Windows\System32, run the FixMapi.exe application.
5. Install the MAPI and CDO client version 6.5.8022.
6. Restart the services for the BlackBerry Enterprise Server and any processes that use the MAPI and CDO client.

If you run the BlackBerry Enterprise Server setup application after you complete the possible solution, when the setup application displays the preinstallation checklist, an error message indicates that the setup application could not detect the MAPI and CDO client. The setup application displays this error message because you installed the MAPI and CDO client version 6.5.8022 in a different directory than the directory that you installed it in for previous versions. The error message does not prevent the BlackBerry Enterprise Server setup application from completing the installation process successfully.
Various BlackBerry Enterprise Server components do not start

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Possible solution</th>
</tr>
</thead>
</table>
| The BlackBerry Administration Service, BlackBerry MDS Connection Service, BlackBerry MDS Integration Service, or BlackBerry Collaboration Service is configured to use a dynamic port when it connects to the BlackBerry Configuration Database, but the database server uses a static port. | Configure a static port for the BlackBerry Configuration Database.  
1. On the computer that hosts the BlackBerry® Enterprise Server component, on the taskbar, click **Start > Programs > BlackBerry Enterprise Server > BlackBerry Server Configuration**.  
2. On the **Database Connectivity** tab, clear the **Use dynamic ports or specify SQL port** check box.  
3. Type the port number in the **Use dynamic ports or specify SQL port** field.  
4. Click **OK**.  
5. In the Windows® Services, restart the services for the BlackBerry Enterprise Server component.                                                                 |
| The BlackBerry Administration Service, BlackBerry MDS Connection Service, BlackBerry MDS Integration Service, or BlackBerry Collaboration Service is configured to use an incorrect static port number when it connects to the BlackBerry Configuration Database. | Configure the component to use the correct port number.  
1. On the computer that hosts the BlackBerry Enterprise Server component, on the taskbar, click **Start > Programs > BlackBerry Enterprise Server > BlackBerry Server Configuration**.  
2. Type the correct port number in the **Use dynamic ports or specify SQL port** field.  
3. Click **OK**.  
4. In the Windows Services, restart the services for the BlackBerry Enterprise Server component.                                                                                                                                 |

You cannot access the BlackBerry Administration Service

Possible cause
The computer that hosts the BlackBerry® Administration Service has more than one NIC and the production NIC is not first in the bind order in Windows® network settings as it must be for you to access the BlackBerry Administration Service.

Possible solution
On the computer that hosts the BlackBerry Administration Service, in the Windows network settings, verify that the production NIC is first in the bind order. For more information, visit www.blackberry.com/support to read article KB18190.

You cannot create a user account in the BlackBerry Administration Service

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Possible solution</th>
</tr>
</thead>
</table>
| The BlackBerry® Administration Service is configured to use static ports when it connects to the BlackBerry Configuration Database server, but the BlackBerry Configuration Database server uses a dynamic port. | Configure the BlackBerry Administration Service to use a dynamic port for the BlackBerry Configuration Database.  
1. On the computer that hosts the BlackBerry® Enterprise Server or BlackBerry Enterprise Server components, on the taskbar, click Start > Programs > BlackBerry Enterprise Server > BlackBerry Server Configuration.  
2. On the Database Connectivity tab, select the Use dynamic ports or specify SQL port check box.  
3. Click OK.  
4. In the Windows® Services, restart the services for the BlackBerry Administration Service. |

The BlackBerry Administration Service pool name is the same as the FQDN of the host computer

**Possible cause**
A DNS record was not created before a BlackBerry® Administration Service instance was installed.

**Possible solution**
1. Create the DNS record for the BlackBerry Administration Service instance.
2. On the computer that hosts the BlackBerry Administration Service instance, on the taskbar, click Start > Programs > BlackBerry Enterprise Server > BlackBerry Server Configuration.
3. On the Administration Service - High Availability tab, in the Pool name field, type the name of the BlackBerry Administration Service pool.
4. In the Windows® Services, restart the services for the BlackBerry Administration Service.
The text in the license agreement is not readable

Possible cause
You have not installed the appropriate languages and text services on the computer that you use to install the BlackBerry® Enterprise Server.

Possible solution
Verify that you installed the appropriate languages and text services on the computer that you use to install the BlackBerry Enterprise Server.
Glossary

AES
Advanced Encryption Standard

AJAX
Asynchronous JavaScript® and XML

BlackBerry CAL
A BlackBerry® Client Access License (BlackBerry CAL) limits how many users you can add to a BlackBerry® Enterprise Server.

BlackBerry Domain
A BlackBerry Domain consists of the BlackBerry Configuration Database with its users and any BlackBerry® Enterprise Server instances that connect to it.

BlackBerry Enterprise Server databases
The BlackBerry® Enterprise Server databases are the BlackBerry Configuration Database, the BlackBerry MDS Integration Service database, and the BlackBerry Monitoring Service database.

BlackBerry MDS
BlackBerry® Mobile Data System

CAS
Client Access Server

CDO
Collaboration Data Object

CDMA
Code Division Multiple Access

DMZ
A demilitarized zone (DMZ) is a neutral subnetwork outside of an organization's firewall. It exists between the trusted LAN of the organization and the untrusted external wireless network and public Internet.

DNS
Domain Name System

FQDN
fully qualified domain name

HTTP
Hypertext Transfer Protocol
HTTPS
Hypertext Transfer Protocol over Secure Sockets Layer

IIS
Internet Information Services

IP
Internet Protocol

IP address
An Internet Protocol (IP) address is an identification number that each computer or mobile device uses when it sends or receives information over a network, such as the Internet. This identification number identifies the specific computer or mobile device on the network.

JDK
Java® Development Kit

JRE
Java® Runtime Environment

LAN
local area network

LDAP
Lightweight Directory Access Protocol

MAPI
Messaging Application Programming Interface

messaging server
A messaging server sends and processes messages and provides collaboration services, such as updating and communicating calendar and address book information.

MSDE
Microsoft® SQL Server® Desktop Engine

NIC
network interface card

RAID
redundant array of independent (or inexpensive) disks

SMS
Short Message Service
SNMP
  Simple Network Management Protocol

SQL
  Structured Query Language

SRP
  Server Routing Protocol

SSL
  Secure Sockets Layer

TCP
  Transmission Control Protocol

TCP/IP
  Transmission Control Protocol/Internet Protocol (TCP/IP) is a set of communication protocols that is used to transmit data over networks, such as the Internet.

TLS
  Transport Layer Security

Triple DES
  Triple Data Encryption Standard

XML
  Extensible Markup Language

WAN
  wide area network
Provide feedback

To provide feedback on this deliverable, visit www.blackberry.com/docsfeedback.
Legal notice

©2010 Research In Motion Limited. All rights reserved. BlackBerry®, RIM®, Research In Motion®, SureType®, SurePress™ and related trademarks, names, and logos are the property of Research In Motion Limited and are registered and/or used in the U.S. and countries around the world.

Safari is a trademark of Apple Inc. Google Chrome is a trademark of Google Inc. IBM, Lotus, and Sametime are trademarks of International Business Machines Corporation. Intel and Xeon are trademarks of Intel Corporation. Microsoft, Active Directory, ActiveX, Hyper-V, Internet Explorer, Outlook, SQL Server, Windows, Windows Media, Windows Server, and Windows Vista are trademarks of Microsoft Corporation. Mozilla and Firefox are trademarks of Mozilla Foundation. Novell and GroupWise are trademarks of Novell, Inc. RSA is a trademark of RSA Security. Java, JavaScript, and JRE are trademarks of Sun Microsystems, Inc. VMware is a trademark of VMware, Inc. All other trademarks are the property of their respective owners.

This documentation including all documentation incorporated by reference herein such as documentation provided or made available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS AVAILABLE" and without condition, endorsement, guarantee, representation, or warranty of any kind by Research In Motion Limited and its affiliated companies ("RIM") and RIM assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or omissions in this documentation. In order to protect RIM proprietary and confidential information and/or trade secrets, this documentation may describe some aspects of RIM technology in generalized terms. RIM reserves the right to periodically change information that is contained in this documentation; however, RIM makes no commitment to provide any such changes, updates, enhancements, or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software, products or services including components and content such as content protected by copyright and/or third-party web sites (collectively the "Third Party Products and Services"). RIM does not control, and is not responsible for, any Third Party Products and Services including, without limitation the content, accuracy, copyright compliance, compatibility, performance, trustworthiness, legality, decency, links, or any other aspect of Third Party Products and Services. The inclusion of a reference to Third Party Products and Services in this documentation does not imply endorsement by RIM of the Third Party Products and Services or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE QUALITY, NONINFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINCE. SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS THE SUBJECT OF THE CLAIM.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL RIM BE LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH RIM PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF RIM PRODUCTS OR SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF RIM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, RIM SHALL HAVE NO OTHER OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY CONTAINED HEREIN; AND (B) TO RIM AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED RIM DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR, EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF RIM OR ANY AFFILIATES OF RIM HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that your airtime service provider has agreed to support all of their features. Some airtime service providers might not offer Internet browsing functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for availability, roaming arrangements, service plans and features. Installation or use of Third Party Products and Services with RIM's products and services may require one or more patent, trademark, copyright, or other licenses in order to avoid infringement or violation of third party rights. You are solely responsible for determining whether to use Third Party Products and Services and if any third party licenses are required to do so. If required you are responsible for acquiring them. You should not install or use Third Party Products and Services until all necessary licenses have been acquired. Any Third Party Products and Services that are provided with RIM's products and services are provided as a convenience to you and are provided "AS IS" with no express or implied conditions, endorsements, guarantees, representations, or warranties of any kind by RIM and RIM assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and Services shall be governed by and subject to you agreeing to the terms of separate licenses and other agreements applicable thereto with third parties, except to the extent expressly covered by a license or other agreement with RIM.

Certain features outlined in this documentation require a minimum version of BlackBerry® Enterprise Server, BlackBerry® Desktop Software, and/or BlackBerry® Device Software.
The terms of use of any RIM product or service are set out in a separate license or other agreement with RIM applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR WARRANTIES PROVIDED BY RIM FOR PORTIONS OF ANY RIM PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.

Certain features outlined in this documentation might require additional development or Third Party Products and Services for access to corporate applications.


This product includes software developed by the Apache Software Foundation (www.apache.org/) and/or is licensed pursuant to one of the licenses listed at (www.apache.org/licenses/). For more information, see the NOTICE.txt file included with the software.

Research In Motion Limited
295 Phillip Street
Waterloo, ON N2L 3W8
Canada

Research In Motion UK Limited
Centrum House
36 Station Road
Egham, Surrey TW20 9LF
United Kingdom

Published in Canada